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Purpose

= This is a no charge event to help customers to be
familiarized with WebSphere Studio Enterprise
Developer version 5 (WSED)

= See product details at
http://lwww-3.ibm.com/software/ad/studioenterprisedev/

= WSED is the follow on of VisualAge COBOL and in near
future for VisualAge Generator.

= Also WSED is the right tool to implement applications
with WebSphere without Java skills
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http://www-3.ibm.com/software/ad/studioenterprisedev/

Audience Pre-requisites

= Audience: Architects, Technical Specialist, and
COBOL developers, responsible for building their
applications using J2EE architecture to be deployed
into WebSphere Application Server V5 with business
logic in the mainframe (z/0S). Also Java developers
interested on the STRUTS tools.

= Pre-requisites: Understand J2EE architecture, some
z/OS experience or understanding. It is desired to
have introductory knowledge of WebSphere Studio
Application Developer. No Java skills are required.
COBOL and 4GL programmers (CSP, VAGEN) are
welcome
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Abstract

The presentations will cover

= "WebSphere Family Product Overview

= " Struts Tools

= " Web Diagram Editor

= " Enterprise Generation Language (EGL)

= " z/0S Application Development Tools

= " |DE for Enterprise Developers

= " XML Enablement Enhancements for z/OS
= "WebSphere Studio Asset Analyzer V2
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Labl - EGL Development and Test

= This lab exercise will take you through the steps of building a
server program using the Enterprise Generation Language
(EGL). The EGL server program will be part of a web banking
application. The web client part of the application, which is
built in LAB2, lets the user enter their account number,
enter an amount to withdraw from that account, and then
press a button to initiate the withdrawal. The EGL server
program is called to perform the withdrawal and return the
account's new balance. The web client then displays the
confirmation page with the new account balance.
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Lab2 - Struts Development with 4GL, Integration, and Test

= This lab will take you through the steps of using the Struts
tools of WSED. You will build the client portion of a web
application and integrate the Struts classes with the EGL
server built in Labl.

m The application is a web banking application. The client
portion of this web application lets the user enter their
account number and an amount to withdraw from that
account, and then press a button to initiate the withdrawal.
After withdrawal has completed, a confirmation page is
returned that also shows the new account balance.
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Lab 3 - Using XML Enablement

m This lab will take you through the steps of using the XML
Enablement component of WSED to create converter
programs that will enable existing COBOL applications to
process XML data. The workshop will generate both inbound
and outbound XML converters for two of the programs
described in the white paper "XML For the Enterprise".
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Lab 4 - Using the z/OS Application Development Tools to Work with
Remote Systems

m This lab will take you through the steps of using the z/0OS
Application Development component of WSED to work with
remote systems. It will familiarize you with the z/0S
Application Development environment. In this workshop, we
will be defining a remote z/OS system, setting up a MVS
project, editing, compiling, and debugging a COBOL
application.
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Lab 5 - Optional - Using J2EE and STRUTS
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The Family WebSphere Studio

SD—» AD— |E — ED

* Profiing/Tracing  ® Service Flow * RAD Tools

Tools Composition

e SD = Site Developer (WSSD)

e AD = Application Developer (WSAD)
e [E = Integration Edition (WSAD-IE)
e ED = Enterprise Developer (WSED)
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WebSphere Studio Family

r

Enterprise Developer

Application Developer Integration Edition

|
Application Developer

[site Developer

¢ User: Web Developer
® Function:
* HTML/JSP Tools
® Servlet Tools
* Web Services Tools
* XML Tools
¢ Target Runtime*:
WAS Express, AE, ND

*

¢ User: J2EE Developer
e Function:
* EJB Tools
¢ Performance and
+ Trace tools
* Component Test tools
® ClearCase LT OEM
¢ Target Runtime*:

WAS AE, ND

WebSphere Studio Workbench

L ® IBM's commerically supported version of Eclipse
P

~N

¢ User: Advanced J2EE
Developer
= Function:

® Access existing EIS
applications using
JCA
® Visual Service Flow
Choreography
® Target Runtime*:
WASE, AE, ND

~ © User: Enterprise

Developer
® Function:

® Create new EIS
applications as

* Visual
Application

* Develop/Maintain
legacy Apps
* COBOL
°PL1
® RAD Tools
= Target Runtime*

WAS AE, ND, E, z/OS

part of a J2EE app

Builder (Struts)

* Basis for IBM Tooling

LR [ Sattrare

Eclipse Workbench

* Universal Tool Platform Initially Developed by IBM
¢ Basis of Open Source Project (www.eclipse.org)

¢ Provides frameworks for tool builders
to focus on tool building

Customer Profile - WebSphere Studio Site Developer

= Typical Customers for Site Developer:

» Customer building Web Applications which does does not require

EJBs

> Customers building/integrating Web Services into their web

applications

» Customers migrating from WebSphere Studio Classic

» Customers migrating from VisualAge for Java Professional

= Skills: Java, Web
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Customer Profile - WebSphere Studio
Application Developer

= Typical Customers for Application Developer
» Customers building J2EE Applications which requires EJBs
» Customers who need Performance/Profiling Tools
» Customers who need component test tools
» Customers migrating from VisualAge for Java Enterprise

m Skills: J2EE, Java, Web
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Customer Profile - WebSphere Studio
Application Developer Integration Edition

= Typical Customers for Integration Edition

» Customers building J2EE Applications which requires enterprise
integration using JCA Resource Adapters:
—CICS, IMS, HOD, SAP, etc

» Customers building application which requires service flow
composition

» Customers migrating from VisualAge for Java Enterprise who used
enterprise access builders

= Skills: J2EE, Java, Web
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Customer Profile - WebSphere Studio
Enterprise Developer

= Typical Customers for Enterprise Developer

» Customers building new EIS appliations which require J2EE xxx
» Java developers who rapidly build Struts based applications

»Non-Java programmers who want to build J2EE applications using a

4GL language

» Customers maintaining legacy applications written in COBOL or PL/I
» Customers developing legacy applications written in COBOL or PL/I
» Customers migrating from VisualAge Generator, VA COBOL, or VA PLII

= Skills: Java, COBOL, PL/I, J2EE
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Product Configurations...
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WebSphere Studio: The
Comprehensive Platform

Discovery (Analysis, Modeling, Design\)
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WebSphere Studio Enterprise Developer

An Introduction to EGL
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WebSphere Studio Enterprise Developer V5.0

= Struts Tools
»Set of Wizards, editors, and validation support
»for the design and construction of Struts-based J2EE web applications

= Enterprise Generation Language (EGL)
»Simple, high level programming specifications
»for creating full-function COBOL and Java applications

= z/OS Application Development Tools
»nteractive, workstation-based development
»for mainframe COBOL, PL/I, ASM applications

= XML Enablement Enhancements for z/OS applications
> Set of wizards to create XML transformation code
>and web services for XML-enabled z/OS applications

ebS AN software

© Copyright 2002 IBM Corporation IBM Confidential 2 POT_WSED-EGL.prz1-2

12/22/02



Key Benefits of Enterprise Developer

= Struts Tools
»Rapid design and quicker understanding of complex web applications
> Faster development with less errors of well-structured web applications

= Enterprise Generation Language
»Rapid development
»Cross platform applications (CICS, WebSphere Application Server)
»Using existing programmers with traditional business skills

= 7/0OS Application Development
»Extends benefits of WebSphere Studio Workbench features/tools to
COBOL, PL/l, ASM programmers
»and the z/OS applications they create and maintain

= XML Enablement Enhancements for z/OS applications
»Faster development of XML-enabled z/OS applications
and of supporting Web Services

ebShere software
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= EGL = Enterprise Generation Language
> Simple, high level programming specifications
»for creating full-function COBOL and Java applications
> Special Parts + Scripting Language + Runtime library
= Benefit: Program development is easier and faster
>EGL hides complexities of implementation technology
=e.g WebSphere Application Server, CICS
»Programmer can focus on business function
= Benefit: Same programmer can develop for many runtimes
»EGL is platform independent
»Write once in EGL, deploy to many platforms and systems
—CICS, WebSphere Application Server (Windows, z/OS), z/OS batch
= Benefit: Programmers can transition their skills to Java gradually

»EGL generates Java code and coexists with Java tools
»Programmer more likely to explore and increase their Java skills

ebShere software
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Enterprise Generation Language

»Migration path from VisualAge Generator's 4GL (end of 2003)

= with significant additions and enhancements necessary
for robust e-business Web Application development

»A new name, linked to IBM’'s WebSphere strategy

=reflects the broad platform AD support that Enterprise customers need
VG Constructs EGL Constructs (R1) EGL Constructs (R1+)
Program ( Program “\ | Web Transactions
Function |» Function =G Adaitions (R1) | Tables
Record f Record IMS DB/DC
Item Structure | Modernized Syntax Text Ul

B Maps Item Select Statement
ﬁ(lgl_l 110 ?_‘I?'-I VO | Muttidimensional arrays
Lzl liz 10 Nested Structures
Multilevel Qualifiers

Bringing forward and enhancing the core technologies created over the lasf
20+ years from CSP to VisualAge Generator
—software
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High Level Specifications

= Simple specifications ADD CUSTINEO
»faster development
> hides technology MQ Connect Queue WSED
p MQ O
= Deployment flexibility Mg Pften oueue
»run on platform of choice Intercept errors
»|owers skill requirement
CALL CUSTPGM DATA INQUIRY CUST _TABLE
B WSED WSED

Marshal data

Convert data Declare Cursor

Invoke CUSTPGM Open Cursor
Fetch

(ClCS, |P, APPC, ) Close

Benefit: Same programmer can develop for multiple
[T software platforms ¥

[
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EGL program example

ezefec =1,
registry.userid =logws.userid;
registry.password =logws.password;
registry.status =-1;
logws.status ="1";
if logws.action ="inquire")
registry-select();
if (registry is nrf)
logws.userid ="";
logws.status ="0";
end
if logws.password !=registry.password)
logws.status ="0";
end
else
if (logws.action ="add")
registry-add();
if (registry is err)
logws.status ="0";
end
else
logws.status ="0";
end
end

|II|||I|
I
g

EGL Development Process

= Develop

»Create EGL parts
»\Write EGL script

= Build
»Generate 3GL from EGL specifications
»Build runtime executables on target platform

= Test

»Use integrated EGL debugger

= Run
»z0S UNIX System Services, Windows NT, 2000, XP
—tier 2 (Java on web application server) and tier 3 (Java)

»CICS for MVS
- tier 3 (COBOL)

ebShere software
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WebSphere software

Develop

EGL Part Types

= Program

Logic

= Function

= |tem
= Record

Data

= Structure

= Build Descriptor

= Linkage Options

= Resource Association
= Link Edit

= Bind Control
nsoftware

Control
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EGL Parts (continued)

= Defined in any order

= Stored/grouped in 3 file types

>.eglpgm - EGL program file

=1 program

=and any associated parts

* Functions, Data parts, .egldef imports

> egldef - EGL definitions file

= Functions, Data parts

—Reusable functions, shared data parts, managed parts
> .eglbld - EGL build file

= Control parts

—Required for EGL generation process

= Authored with
»EGL Parts editor: fill-in-the-blank GUI's
»EGL Source editor - source text editor

ebShere software
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Benefit: Fast development for the experienced programmer

ebShere software
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Editing EGL files - EGL Parts Editor

]

3 :::;.m 1m mm o ‘:‘I" : 4 I
2 N\ l_l

[5a] 200tz - Warkng Foord | 37| Tasks [0 kears]
|1l | cescrptian Amsares [ inPekar

i *
& ¥ || Temkn |54 Errars | Garsration Pl

Benefit: Easy development for the novice programmer
—software
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Editing EGL files - Description

1. In the Navigator view, double click on an EGL file
» File is opened with the editor last used (parts editor or source editor) and is
opened in the Outline view (To change editor, right click on the EGL file,
select Open with..., and select EGL Parts Editor or EGL Source Editor)
2.In the Editor, tabs at the top are for opened files
» highlighted tab is active file
» click on tabs to switch between files
3. Outline view shows parts defined in the opened EGL file
> First part in EGL file is opened for editing when file opened
» Double click on a part to open it in the Editor
4.1n the Editor, bottom tabs are for opened EGL parts
>tab with the "X" is the active part, click on "X" to remove part from Editor
» click on tabs to switch between parts

5. Active part may have multiple property pages
» Script, Signature, Variables, SQL properties, Default SQL

iﬂk on buttons to switch between pages
TSR software
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EGL Logic parts

" Program Programl
»Main logical unit
= Tested with EGL debugger Script
= Becomes runtime executable Datal
»Use EGL script to define logic
»Can receive parameters FunctionA
»Can have data areas Tlpt
= Function DataA
»Callable logical unit
L —invoked from program or another function FunctionB
=reusable RS
»Use EGL script to define logic Script
»>Can receive parameters, pass return value DataB
»Can have local data areas

ebShere software

[hnf]
Il
i

LT}

1l
il
14

EGL Data parts

= [tem = Record
»a memory area that cannot be >a structure with a type specified
subdivided =Working Storage, SQL row,
>e.0. Message Queue, sequential file,
etc.
indexl BIH{4): |
>e.0.
Becord acsount:
" StrUCture . 2:?%-'\'dbhdnu scooant™® TL®
»a collection of memory areas 10 ACCT_HOMBER BEN(); < &2CT HUHRER
10 cOST_ID BIH(R): < CORI_ID
>e.g. 10 BALAWCE PACK(10.2): < Bal
SOLl texProperties
ibem=ACCT_HUTHEER
- structure acctvs colosafane: "ACCT HUKEER®
%g ACCT_NUMEE% Kla(llla(g)) ; /¢ HCCT_NUMBER ﬁiﬁf?émmm
t t P P g v t =
10 BALINCE PACK(102)  BALENCE i LS,
end SOLI tenProperties
1bem=CIST_ID
colusaNams="COST_IDY
SOIDataCoda= {97
isley=R0
" isEeadlaly=H0
EﬂlIlﬂhnpe:rr.ie-:
nsoftware EE??E

12/22/02 © Copyright 2002 IBM Corporation IBM Confidential 2 POT_WSED-EGL.prz17-18



12/22/02

Using Data parts

= Must be defined

»Specify part characteristics
»\Vithin an .eglpgm or .egldef file

= Must be declared
»Specify as parameter or variable within a logic part
»e.g. Program account(acctws acctws) ...
- (acctws acctws) is an example of a parameter declaration
= (acctws acctws) is the name used as a qualifier in the script
= (acctws acctws) refers to a data part definition

= Referenced in the script of a logic part
»Examples
=unqualified: balance = balance - txnAmt;
= qualified: account.balance = acctws.balance
» Defining or declaring a variable before scripting is not required
=hut this reduces the help that code assist can give
software

[hnf]
Il
i

LT}

1l
ol
14

Using Data parts example

Data/oart declared as parameter

import "AIS egldef”:
account account;

indexl BIN{4);

script
account . ACCT WUMBER = acctws. ACCT_HUMBEE
update account on exception
szertn();
end
if {account not err)
account . bALANCE = account bALANCE - acctws. tzn_anmt:

replace account on exception
erertni);

end

acctws BALANCE = account  bALANCE;

end
scriptend

Data part referenced

TEecord accLvs
10 ACCT HUMBER BIW(9). -~ ACCT HUMEER
10 tzn_amt PACK(10, 2): -~ t=n_amt
10 BALANCE PACK(10,L2): - BALANCE

end
23en \
24

Data part defined

ebShere software
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Script - Writing logic with EGL

1. Assignment
2. Keyword
3.1/0 keyword
4. Function
5.EZE words

sz=cript
account  ACCT HUMBERE = acctws ACCT HUMBER:;
update account on exception

Ezertn{ 1;

end
@if {account not err)
account bALANCE = account BALANCE - acctws.
é) replace account on eEception
ezertn();
end
@acctws.bﬁlﬁNCE = account  bALANCE:
En

s=criptend

ebShere software

txn amt;
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Using Content Assist

= View and paste statement templates into the script
»shows list of EGL statements
= variations in syntax also shown

= View and paste declared data parts into the script
»Ctrl + Space, select declared record
>type . (decimal point), then Ctrl + Space to get list of data items

= View and paste EZE words
»Ctrl + Space, then *

= Content Assist activated by:
»Context menu item, Content Assist
»Ctrl + Space

= List shown will be narrowed to typed characters that match
Benefit: Less keystrokes = Faster development

ebShere software
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Writing SQL requests

= Access a table, a view, or a join of tables or views
- UDB directly from CICS
=all others via JDBC

= Begins with 1/0 keyword, may be terminated with "end"
=add, inquiry, update, delete, replace, seting, scan, sglexec
= update account on exception ezertn(); end

= [dentify a record definition for SQL row
= update account on exception ezertn(); end

_ = [dentify SQL clause
—optional, if not present, then default SQL clause is used
=in most cases you can modify the default SQL
- update account statementiD=account-update on exception ...

= |dentify what to do if an I/O error occurs
= update accounton exception ezertn(); end

ebShere software
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Program definition summary

@*account.eglpgm X 2 .~ Makes other part definitions usable
iimport "AIS egldef"’
Program account{acctws acctws) <— (Parameter)
3 account account: .
o 1 |indexl BIN(4): | <a— Variables
rogram 5 SCript
2L D
definition | ¢ sccount . ACCT_NUMBER = acctws.ACCT_NUMBER:
7 update account on exception
8 szertn();
*- end
. P if {account not err)

business | 11 account .BALANCE = account .BALANCE - acctws. tzn_amt:

logic 12 replace account on exception
113 ezertn();
14 end
15 acctws. BALANCE = account  bALANCE:
16 end

I 2 scriptend
18 TECOTO acCtws
19 10 ACCT WUMBER BIMN(9): .~ ACCT HIUMEER
20 10 txn_amt PACK(10,2); // txn_ant
21 10 BALANCE PACK(10, 2); -~ BALANCE
27 end
23en
24 . Data part definition
(TR software TOoRE
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More details

Script syntax rules

= Statement terminated with a semicolon
»optional for "end” statement

= Statement can continue onto multiple lines
= Multiple statements per line allowed

= Comments
>single line: text between // and EOL character
»multi-line: text between /* and */

= Block-containing statements are terminated with end delimiter
>|F, SELECT, WHILE, ...

= Brackets [ ] used for subscripts
= Parentheses () used for grouping, as in a math expression
= Names in statements and throughout EGL are case-insensitive

il
L]
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Statement Types

= Assignment
= Keyword
= Function
= EZE words

ebShere software
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Assignment statement

= Form: target = source;

= Target: data item, data item eze word, declared record or structure

= Source:
»|f target is data item or data item eze word, the source must be numeric or
string expression

=complex series of symbols:  z=a+b+c;
- data item or data item eze word:  myDate = ezedte;
—function invocation: myltem = readFile(myKeyValue);
-literal:  ezeuserid = "USER";

»|f the target is a structure, the source must be a structure

»|f the target is a record, the source must be a record
=myRecord01 = myRecord02

il
L]
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Assignment statement examples

= Copy data from one area to another
= registry.password = logws.password;
=registry.userid = logws.userid;

= Places a value into a data area

»The result of an arithmetic calculation
= myDataltem = bigValue - 32;

> A value returned from a function invocation
—myltem = readFile(myKeyValue);

» A literal
=gzefec = 1;
=registry.status = -1;
=logws.status = "1";

ebShere software

Keyword Statements

call transfers control to another program and optionally passes a series of
values. Control returns to the caller when the called program ends. If
the called program changes the passed data, the storage area available

to the caller is changed,too.

if, else if marks the start of a set of statements that run only if a logical

expression resolves to true. else marks the start of an alternative set
of statements that run only if the logical expression resolves to false.

select select marks the start of multiple sets of statements, where at most only

one of those sets is run.

set Initializes the value of each structure item in a record or sets a structure

item in a SQL row record to null

while marks the start of a set of statements that run in a loop. The first run

occurs only if a logical expression resolves to true, and each
subsequent iteration depends on the same test.

ebShere software
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/0 Keyword Statements

add places a record in a file, message queue, or database

close detaches the file or message queue associated with a given record; or,
in the case of a SQL record, releases the unprocessed rows that were
selected by an update. setupd. or seting statement.

delete removes either a record from a file or a row from a database.

inquiry reads either a single record from a file or a single row from a database.

replace replace puts a chanaed record into a file or database.

scan reads the next record from a file, messaae queue, or database.

scanback | scanback reads the previous record in the file that is associated with a
specified EGL indexed record.

set Establishes position in the file associated with an indexed record

seting selects a set of rows from a relational database for later retrieval with
scan statements.

setupd selects a set of rows from a relational database for later retrieval with
scan statements; in this case, each scan locks a row for subsequent
replacement or deletion.

sglexec lets you write an SQL data-definition statement (of type CREATE
TABLE, for example), as well as data-manipulation statements of type
DELETE. INSERT. or UPDATE but not others.

update reads and locks a record/row from a file or in a relational database.

Iy Update is followed by a replace or delete against the same record.

Boolean operators - IS / NOT

= |S - tests true if the specified state is true

= NOT - that tests true if the specified state is false

Examples:

IF SQLrecord.item

ebShere software

IF dataitem — IS —l_ BLANKS
—— NUMERIC

NOT
IF record IS HRD
NOT ERR
NRF
DUP
DED
UNQ
IS ———T— BLANKS
NULL
NOT NUMERIC
TRUNC

[l
[l
Ll
il
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Using Multiple EGL Files

= egldef files enable part sharing
»DB definitions, reusable functions, etc
»|ess maintenance
»control/ownership can be by another

= IMPORT statement
»links to the named EGL definition file

= AccountRec example
»Scenario 1: defined twice, maintain both
»Scenario 2: defined once, definition shared

= Scenario 2

DetailPgm.eglpgm
> Import AlS.egldef
> ReadAccountFn

ListPgm.eglpgm
» Import AlS.egldef
> ListAccountFn

AlIS.egldef
» AccountRec

= Scenario 1
DetailPgm.eglpgm ListPgm.eglpgm
»ReadAccountFn » ListEmployeeFn
»AccountRec » AccountRec
—software
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Typedef Example

= |f this structure definition exists

Structure address
10 streetAddress CHA(20);
10 city CHA(15);

end

Structure personnel
10 homeAddress address;
10 workAddress address;
end

| Structure personnel

10 homeAddress;
20 streetAddress CHA(20);
20 city CHA(15);

10 workAddress;
20 streetAddress CHA(20);
20 city CHA(15);

end

ebShere software

= Then address could be used as a typedef in a new structure

= This is equivalent to defining personnel as
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Language Constructs

ebShere software
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Function Invocation statements

= Directs processing to:
>another script
»function eze word

= [nvoke with no arguments

»callMax();
»EZERTN():

= [nvoke with arguments
»CallMax(num1,num2);

= [nvoke inline as value
»LargerNum = callMax(num1, num2);

ebShere software
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= Used in logic
»ezefec = 1;
»ezertn();

= Provide access to many system-provided values

»date and time
»runtime environment information

= Provide useful functions
»such as mathematical and string operations

ebShere software
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EZE Words (continued)

EZEFEC
> Controls continuation after hard I/O errors
> |f EZEFEC is set to 1 and an error routine is specified
e hard I/O error is bypassed and processing continues
o Application is responsible for reporting error to application user
» Example: EZEFEC = 1; /* Should be in every program
EZESYS
> ldentifies environment in which program is running

> Not available in a Java wrapper

o Example: IF (EZESYS IS "MVSCICS")
B my-vsam-fnc(); [* Peform VSAM function */
END;

EZEUSRID

» Contains the user ID that is currently logged on
e Example: AUDIT-LOG.USERID = EZEUSRID;

il
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EZE Words (continued)

EZECOMIT
» function that calls services to save recoverable file, database,
and message queue updates since the last commit

» The scan position is lost and update locks are released for any
files or databases affected by the EZECOMIT

> An exception to this occurs when using Declare Cursor With
Hold

* Example: EZECOMIT();

EZEROLLB

» function that calls system services to back out recoverable file,
database, and message queue updates since the last commit
point

> rollback occurs automatically if the program ends with an
unexpected error
* Example: EZEROLLBY();

ebShere software

Itn:ll
i

1k
ol
14

String Handling

EZESBLKT Changes null terminator and any subsequent
characters in a string to blanks

EZESCCWS Concatenates one string to another, with a separator
string between them

EZESCMPR Compares one substring to another

EZESCNCT Concatenates one string to another

EZESCOPY Copies one substring to another

EZESFINDFinds the first occurrence of a string within a string

EZESNULT Changes trailing blanks to nulls in a string

EZESSET Sets each character in a substring to the same
character value

EZESTLEN  Returns length of an item less trailing blanks and nulls

EZESTOKN  Finds next token in string and copies it to an item

il
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Math Routines - General

= EZEABS Absolute value

= EZECEIL Smallest integer not less than the numericDataltem

= EZEEXP Exponential value (e raised to power of numericDataltem)

= EZEFLOOR Largest integer not greater than numericDataltem

= EZEFREXP Split numeric data item into normalized fraction in range of
1/2 to 1 and a power of 2

= EZELDEXP Product of numericDataltem multiplied by 2 to the power of
integer

= EZELOG Natural logarithm

= EZELOG10 Base 10 logarithm

= EZEMAX Maximum

| = EZEMIN Minimum

= EZEMODF Splitinto integral and fractional parts

= EZENCMPR Numeric comparison

= EZEPOW Raise to power

= EZEPRCSN Maximum precision in decimal digits

= EZEROUND Round to integer power of 10

= EZESQRT Square root

_software EEE

Math Routines - Floating Point

= EZEFLADD Floating point add
= EZEFLDIV Floating point division
= EZEFLMO Floating point remainder of division
= EZEFLMUL Floating point multiplication
= EZEFLSET Convert to floating point
= EZEFLSUB Floating point subtraction
software EE:??E
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Math Routines - Trigonometric Functions

= EZEACOS Arccosine
= EZEASIN Arcsine
= EZEATAN Arctangent
= EZEATAN2
the rectangular coordinate
= EZECOS Cosine
= EZECOSH Hyperbolic cosine
= EZESIN Sine
= EZESINH Hyperbolic sine
= EZETAN Tangent
= EZETANH Hyperbolic tangent
nsoftware

Theta component of the polar coordinate corresponding to

[hnf]
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Arithmetic expressions

Unary operators

+ The operand is used without changing its sign
- The value of the operand is negated

Binary arithmetic operators
+ Operands are added

- The second operand is subtracted from the first operand

* Operands are multiplied

/ The first operand is divided by the second operand

I The result is the remainder of dividing the first operand by the

second operand
Examples:

PERCENT-CHANGE = (NEW-VALUE - OLD-VALUE) * 100 / OLD-VALUE;

OP1 = OP2 + OP3 * OP4;
OP1 = OP2 * (OP3 + OP4);
OP1=-OP2 + OP3;

OP1 = OP2 + OP3[INDEX];

ebShere software
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Control Parts

= Build descriptor
»controls the generation process
»used for generation

= Linkage options
»describes how to implement program calls or access remote files
»used for test, generation, and execution

= Resource associations
»links EGL record to a file or message queue to be accessed
»used for test, generation, and execution

= Bind control
»for z/OS, DB2 bind control parameters
»specified at generation time and used in executable preparation
= Link edit
»for z/OS, describes how to form a load module from two or more programs
»specified at generation time and used in executable preparation

ebShere software
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Update Function - SQL Statement

= Updating a row is a two step process

»First, perform an UPDATE
»An UPDATE selects and locks the rows involved, thus determining data
availability and preventing other users from updating the same data

| = prafac-updat 501 Statanant Upcdater an acecinit el W ElN OB
| Dafault SO0 Sabemert Stebement 10 | profac-updste
[Teamt: .
| [PELECT USERIC. FULLNAME. 0CEES|E) profcupdate  Serpt Update an account profle.

Inbo:

profile userid = profws. userid;

[[TRTD

{[:pzotile EMAIL. -profile CREDTT

profile USERLD :Prﬂflleﬁ update profile updateld=profuid statementID=profac-update;
i if {profile not err)

| [From: profile = profws;
jFron TRINEFRCE TLRAE SR T1 replace profile updateld=profuid statementID=profac-
e ezertnl);
| | hee, hewing, arous by end;
| IHTFE uwsarid =:us=rid elze
| profws. status = "0";
For updatz of: end

| OFDATE 0OF USERLD,. FULLHANE.

ebShere software
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Replace Function - SQL

& prafac-update. Scripk
prof ile . userid = profus. userid;

if (profile not esrr)
profile = profws:

ezertnl);
end ;
else
profws. status = "0";
end

* The second step is REPLACE

> Replace performs the actual update of the
row(s) selected by the UPDATE function

> New values must be moved into the
PROFILE record for any data items that are
to be changed

» CURRENT DATEor CURRENT TIMESTAMP
may be used to indicate when a row was
last updated

ebShere software

Update an account proﬁiia . . [D]

update profile updateld=profuid statementID=profac—update;

replace profile updateld=profuid statementID=profac—update on exception

& profac-update. SQL Skatement Updz
Default SOL Statement Statement ID:
Update:

UFDATE TRADEFROFILEBEAN

Sef:

SET

USERID = :profile USERID,
FULINAME = :profile FULLHAME.
ADDREESS = :profile. ADDEESS,
EMATL = :profile EMATL,
CREDITCARD = :profile CREDITCARD

Where current of:
WHERE CURRENT OF eze_cutsor_nnn
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Generating source code from EGL

EGL generated Compiled runtime
source files objects @

Build c@nmand - :ﬂ]ﬂ]]]]]]mmm

and source files

Compiler

- console output M

Enterprise Developer Build Server
Workstation

ebShere software
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Enterprise Developer Build Process

= Automated build based on build plans (XML)
= Automatic transfer to target machine
= Run build commands on target machine Build Servers

Workstation Client

TCP/IP .
Socket Win

WSED Build command

Build
Command Build command @ USS
Socket
Processor Build command
Cobol
TCPA
SHEE Socket TSO

Benefit: Developer spends less time in the build process
nsoftware
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I
N 1N i .
Validation __ __/ \\ Generation  \ T T -
/ \ ——————— VAN P ~o
I/ \ - / \\ . // \\
| = EGL program \\ _g)\ l/ ~ Build \ Sl / \
I = Target system \ Bl Descriptor \\ E_% l’ e — \‘
[— Build NE=L I Options ); o )\ )
1 : < | - i / il Outputs
| Descriptor / S \ Auxiliary y o \\ /
\ Options / \ input parts / (0] N 4
\\ A T I 1 R N N ~ s
N - L !// ISR~ _ — ///
\/ - / =T
I/ ] 4 \ v
/ NG A\
. > \ 7
Preparation__ —————___ TCPIP M\ /
//’ \\\ </
-~ N
s
/ N T I WSED Project
ll Final EGL //i.\___ll Compiling, Linking, i
and Binding on Target
\ execqt_ables_ and \\ __.JI ¢ Y ! Compile occurs on file
System |
\ auxiliary files \)7' i change
\\ / (using Build Server) |
N e ]
\\\ ////
Build Servers
TSR software EE?{

EGL Generation

» Create 3GL source code

> Java or COBOL from EGL program specification

= Create Java wrappers

»Java Wrapper makes access to generated EGL program easier
»EJB Session Beans can be generated as well

» EGL Build Descriptor parts are required for each

~

p
_»l
-
-

L

////
: -
':\\\
>~
1 - b
— I PR v
~< Mmy_page sp

(View)

L

Browser

S T,

-

|

-
71
‘I /

y /
[
\

|
| | Action subclass
= | ActionServlet pr——————— -yl.__(c_ogfr_oll_eo__;

/ S
— 1

Business logic 1
R Y
\
\

v

EGL Java le—— - EGL

Wrapper J COBOL
I Program

(EGL Java) 1

EGLBLD 4
parts L+~
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Build Descriptor for Java Generation

= Generate EGL program

> as Java code
»for WebSphere Test Environment

ﬁ win-java

Build option filter |SEREREEES=E = TRE )

v Show only specified options

Option ' Walue (F1 For Help)

debug YES

genProject ATMWeb

genPropetties YES

JZEE YES

packageMame egl

sqiDE jdbc/als

system WIN
T software

®= debug
>if yes, runtime debugging enabled

= genProject
»project to store generated outputs

® genProperties
> create properties variables
> placed in deployment descriptor
= J2EE
»execute in J2EE runtime
® packageName
»folder(s) to store Java source and
classes
" sqiDB
> DB name for genProperties
= system
> Target generation platform
>Win = Java source for Window:

il @
i
L]

Generation Results

= Generation Results window will appear

>With Validation Messages
»Successful generation

= Validation messages are cross field validation and need to be
corrected for generation to complete successfully.

§ Geresatinn Reswults

ol b AL 35855,/ Gy pnatelesd b Copatm sz vt np e, |

ebShere software
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Generation Outputs for Java Generation

Source Part Output Type Generated Name Example

Program Server Program | partname.cbl LOGAC.CBL
partname.java LOGAC.java

Records/Structures | Java Code Ezepartname.java Ezelogws.java
in Java Server Ezeregistry.java
Programs
Records/Structures | Java Code Eze$param functionname Eze$paramFuncRec.java
used parameters in parametername.java
functions
Functions used in Methods in $funcfunctioname $funclogin

Java program

server program

Program

Debug Control
XML

partname_debug.xml

LOGAC_debug.xml

Program

Build Plan XML
(for remote
build)

parthameBuildPlan.xml

LOGACBUildPlan.xml

Program

Text file for
runtime
properties

partname-env.txt

LOGAC-env.txt

| e 1}

Note: '-" will be changed to 'x002D' in java hames (no quotes)

Generation Outputs for Java Wrappers

Source Part Output Type Generated Name Example
Program Java Bean partnameWrapper.java LOGACWrapper.java
Records used as Java Bean partname.java logws.java
parameters in or
programs typedefname.java

Note: -' will be changed to 'x002D' in java names (no quotes)

ebShere software
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WebSphere software

Test Scenarios

= Testing an EGL program alone
>e.g.called EGL server program
= or batch EGL program
»runs in JVM, no J2EE web container required
- More test turn arounds
* environment starts faster, runs faster

> Source level debugging with EGL debugger
Benefit: Faster iterative development and test

= Testing a complete web application
- >e.g. web client calls EGL server program
»runs in J2EE container
- e.g. WebSpere Test Enviroment
»Source level debugging for

= JSP, Java, EGL
Benefit: End-to-end test and debug from the Workbench

il
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Testing an EGL program alone

= One time setup

> Create a debug Build Descriptor
»Set breakpoint(s) in the program

=at least one at the beginning of the program script to initialize variables
»Define a Launch configuration

= Repeat for each test

»Generate the program's EGL into Java
- everytime the program or one of its parts has changed

»Start the Launch configuration
»Initialize variables

=e.g. parameters for called EGL program
- alternative: create a test client EGL program

»Debug program

ebShere software
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Build Descriptor for non-J2EE Test

= key options ® debug
>debug = YES >= YES, creates debug mapper
»J2EE =NO = genProject

»project to store generated outputs
®= genProperties

£ debug > create properties variables
> placed in program.properties file
Build option Filker ]Java Debugging (ol _v_j = OEE

v Show only specified options:

»=NO, create Java for non-J2EE

Opticn ‘ Value (F1 for Help) - packageName
debug YES
genProject ELDebug > folder(s) to store generated Java
genProperties YES
TPEE NG " sqiDB _
packagshame gl > DB name for genProperties
sqIDE jdbcidbz: ATS .
sqlIDBCDriverc... COM.ibm.db2.jdbe. app. DEZDriver = 5qlJDBCDriver
system WIN > driver for genProperties
= system

> Target generation platform

[T software »>Win = Java source for Windows= ==
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Create a launch configuration

= Defines a context in which to run your code

= Define once and reuse

o Laumch Configetises

Crepbe ssansge, snd ien Lvends conli geratlsns

Lannch Canfigurabions:

B
2 Aitachio 8 Punring Proges
= Cubug & Conpled Applkcaton

= S Cwbusg aniEXL Jarvs prograns

=
11 Jowt bppbcaion :
1y, Jowt Been F::: —
Ju Rk —
(% Amnots Jave 8 ppication
W Aun-tea Warkbanch
= B ey s
B welrichere G o Erwy | S350
0 T Procedune Cebugger
Wb Zphare Fppl i atior S
1§ wah=phare 1ok Appkeation O
Wt St 6 Apphoation O

£ ¥

Lt | 4 Zorwson |

e | peee |

_ vkl | i |
[oohw ] e |
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EGL Debugger

T L R - | R e

=1 % accounc [Lob g an BQL Xna progran]
3B Clamsc 04 Debug console

w My Gy ke Themad [Signal dispabchar] {funring)

My Sy sbwn Themad [Finalzar] {Runring)

+ - Spatem Th nad [Anfenencs Handler ] Rurning]

=@y Threed [aooourt] maspandad {breakpont et bre 5 i oot sgiogmd)
= mermnt bm; Sacoont]
= ook, neie Srng [ e L6

- AT
o 3 EZE Words
= @ mchen

Py ACCT_MUMBER =2
dly LAk =

@ DALARKE =0
= o
4 OCCT_WUMALR =0

U7r

¥ = t CUsT =0 R .
- S mm=?Initialized variable
Diebig Sz | Warisbles Eveskp.. Expres..  Regklers Forsges Starsg .. Monibos (M
x| g

1import "A[S =gld=i®;
ZPEOraR Soooubt(acntes acnhes)
| scEmunk scoount
Soript

e
if [socount mot err)

EGL script

accoint . BALANCE = sccoutit hALARCE — accoos. ixn_smt

Toaplsce e-c?cmn.t- om sEcepbion

wncd
acche= bALAMCE = account bALAHCE

-:ri mal
Breakpoint
- software

| BE| e

- Impaits
o AT kil
- E [ =T 4
[= 0] Pararsters
b [ Varnsbla
Serict
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Testing a complete web application

= e.9. Using WebSphere Test Environment

= One time setup
»Create Build Descriptors for server and wrapper generation
»Set breakpoint(s) in the program
—at least one at the beginning of the program script to initialize variables

»Create Server and Server Configuration
- Define Data Source in Server Configuration

= Repeat for each test
»Generate the program's EGL into Java
= everytime the program or one of its parts has changed
= use server and wrapper Build Descriptors
»Start Web project on Server
=right click on web project name and select
* "Run on Server"
® "Debug on Server"

ebShere software
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Moving to Websphere

ebShere software
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Action subclass
(Controller) Runt|me oL

LD—» CICS COBOL
\ EGL Java Wrapper | . ( Program

s
v
( \
Browser Ay SR Business logic
- l (View) (| (EGLJava) J\
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CICS Transaction Gateway

ebShere software
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J2EE connector architecture (J2C or J2CA)

J2EE Server Runtime
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Connection, transaction and
security services

EIS
(cics)

Resource Adapter
for the EIS IMS

Connection, transaction and
security services

EIS
(IMS)

Resource Adapter
for the EIS SAP

AN

Connection, transaction and
security services

/\

EIS
(SAP)

T software Included with WebSphere

i

L

Provided by EIS vendor
or Third Party vendor

[l
Il
i

LT}

1y
il
1

© Copyright 2002 IBM Corporation

IBM Confidential

2_POT_WSED-EGL.prz67-68




12/22/02

Struts page

R —

Model
Object

EGL
—®1 Program

Wrapper

Struts action
class

COBOL/CICS
EGL
Generated
Progam

WebSphere
using J2C

nsoftware EEE
© Copyright 2002 IBM Corporation IBM Confidential 2 POT_WSED-EGL.prz69-70



WebSphere software
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WebSphere Studio Enterprise Developer
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POT - Lab Introduction
Jan 2003

Reginaldo Barosa

Certified IT Specialist
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IBM Software Group oston

rbarosa@us.ibm.com

Lab #1 - EGL Lab

= Use EGL to build a server program

» this is a back end of the ATM Withdrawal web application
> the server reduces the balance for a specified account by a
withdrawal amount

» the server returns the new account balance to the caller

eSphre RS




Lab #1 - Tips

= Make sure you use a different workspace from the
one you used for WebSphere Studio Application
Developer

= \Working with Tables

> EGL frequently makes use of tables in its wizards and editors.

=¢.g. EGL Build Descriptors in the EGL Parts Editor

> Tabbing out of a field in a table will ensure that the value is not "lost".

> Tabbing from cell to cell in a table is often faster then clicking on the
cell to edit (see next comment).

» Editing a cell in the table requires 2 "slow" clicks - the first to select
the cell, the second select the contents of the cell for editing. If the
cell has a drop down button, then a third click will show the drop down
list.

‘WehSphere Eaifit ===

Lab #2 - Struts Tools

= Design and build the front end of the ATM Withdrawal
web application using Struts tools
»a JSP accepts an account # and withdrawal amount from the user

> calls an EGL server from a Struts action
»a JSP displays the new account balance.

‘Wehsphere Bl it = ===




Lab #2 - Tips

= Using Page designer
» If Jsp editor behaves unusually, close and reopen. This is particularly
true, when a Jsp is first created.

= Tables
»>the tips in Lab #1 apply in this lab as well

Y sottware isswn

Lab #3 - z/OS IDE

= Part | - Setting up DEMOMVS system
» DEMOMVS userid obtained
» Create partitioned datasets (PDS) to be used in Part I
» Primer for navigating around TSO/ISPF

= Part Il - Using z/OS IDE to work with host artifacts

» Defining and connecting to host systems
> Working with host artifacts thru the MVS project

Y sottware iman




Lab #3 - Tips

= Due to network latency, datasets you've added to
your MVS project may "disappear". To resolve this,
do a connect again to the system from the z/OS
Systems view.

Lab #4 - XML Enablement

= Use the XML enablement wizard to create
» Inbound converter program
» Qutbound converter program
> Template driver program




Lab #4 - Tips

= Make sure you're working from a SIMPLE project.
» MVS projects cannot be the source/target of the XML enablement
wizard.

‘WehSphere Fuidth AT Ewve

Lab #5 - Optional -Working with J2EE and
STRUTS (Part 1)

= Could apply for any version of WSAD
= Requires some J2EE and Java Skill.

= Optional..
> This Lab could have small bugs it will be updated in near future.

 \WehSphars Studa
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Lab #6 - Optional -Working with J2EE and
EJB (Part 1)

= Could apply for WSAD
= [tsused in Lab 5
= Requires some J2EE and Java Skill.

= Optional..
> This Lab could have small bugs it will be updated in near future.
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WebSphere Technical Exchange

Struts-based Web Applications
w/Studio Enterprise Developer

© 2002 IBM Corporation

WebSphere Studio Enterprise Developer V5.0

® Struts Tools
» Set of Wizards, editors, and validation support

» for the design and construction of Struts-based J2EE web
applications

m Enterprise Generation Language (EGL)
» Simple, high level programming specifications
» for creating full-function COBOL and Java applications
® 7/OS Application Development Tools
» Interactive, workstation-based development
» for mainframe COBOL, PL/I, ASM applications
= XML Enablement Enhancements for z/OS applications
» Set of wizards to create XML transformation code
» and web services for XML-enabled z/OS applications

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation

Struts

D52/1-2
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Objectives and Agenda

In this session we learn

O Struts Overview

» Model-View-Controller 2
» What is Struts?
» Struts application and components

O Struts Example
» Small example

Q Struts in Application Developer
» Implementing Struts in Application Developer

o Struts in Enterprise Developer
» Struts support in Enterprise Developer
» Wizards and graphical design tool
» Enterprise Generation Language

L "
«® Redbooks 2002 B Coporaion Ry

Struts Overview

Vg, "
L@ Hedbﬂﬂks © 2002 IBM Corporation m

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation D52/3-4
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Tier-1 Tier-2 Tier-3
Web Web Server Data/Backend
Browser server

WebSphere Application Server

Transaction
Program

Connectors

’ Java Servlet

el
Q \ *nvokes

RE:?&T_SE . \ JavaServer -
: Page .
' ' Database
) T .
' ' '
' Java Virtual Machine !
. .
. []
Need an architecture!
I
Q@ Hedbm)ks ©2002 IBM Corporation —

L]

View Controller Model

Backend
Transaction

| Serviet Program
L ava Servle (EGL/COBOL/etc)
- / z \
4.
: ‘ JavaBeans

3. A o EJBs -
g — @ Database
Session

WebSphere Application Server

5.
\ JavaServer
Page

= Separates component responsibilities
= Exploits strengths of each component (“best practice”)
m Promotes reuse

k@ Redbooks ©2002 IBM Corporation

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation D52/5-6
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Implementation of the MVC Architecture

Controller "glue" code rewritten many times
0 Receiving parameters from HTML form
0O Validating form fields/setting error messages
a Control flow/navigation logic
O Saving state in session

Hand coding of JSPs repetitive and time consuming
a Creating dynamic elements (form fields, etc)
a Common JavaScript (e.g. setting focus)

Model logic
Q Usually requires Java skills
O Population of beans for JSP elements repetitive

==> Something needed to help with these issues !

L "
«® Redbooks 2002 B Coporaion Ry

What is Struts?

A framework for building well-structured
JSP and servlet based Web applications
Q Supports/encourages MVC

o Uses concept of "action"” classes A set of
Includes facilities to simplify: CIOOpera“”g
O Form input handling and validation Sl
) ) servlets,
@ Error handling and reporting d JSP
Q Control flow ?” il
0 JSP tag libraries to simplify JSP development ags tha
make up a
Open-source Apache Jakarta project reusable
O http://jakarta.apache.org/struts/ MVC design

o Struts Version 1.0 was released 6/01
a Current 1.0.2 (and 1.1 beta)

L "
L@ HBdbDOkS © 2002 IBM Corporation M

™

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation

Struts
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Struts Application Flow

Model

Business
Logic

Backend

View Controller

Form Bean
Action —H Action
/n/.' Servlet < n Class

— ] 2
<_/Action Forward

JavaServer
Page

Session

L "
«® Redbooks 2002 B Coporaion Ry

Struts Components

ActionServlet
o Generic, provided by Struts
o Fills HTML form data into form bean and calls action class
Q Calls JSPs or actions based on return from action class

Struts binaries

Form bean (subclass of Struts ActionForm) distributed in
O Simple JavaBean with form data from HTML .
0 Performs validation of input data

Action class (subclass of Struts Action)

a Controller, uses form bean and invokes business logic fgnuftigs;uration
O Returns an ActionForward to the ActionServlet leti%rri,vseesnt,?;
ActionForward

O Symbolic name of next action (JSP or action class)
O Used by ActionServlet to invoke next action

L "
L@ HBdbDOkS © 2002 IBM Corporation M

™

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation D52/9-10
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Struts configuration file (struts-config.xml)
0 Contains mapping of actions (in HTML form) to actions classes
o Contains mappings of ActionForwards to JSPs or actions
O Used by the ActionServlet

Struts tag libraries

0 Ease coding of JSPs through symbolic text variables
struts-bean.tld, struts-htm .tld, struts-logic.tld,
struts-tenplate.tld

o Texts defined in ApplicationResources.properties
» Headings, labels, buttons, error messages, ...
Error handling

a ActionErrors and ActionError provide easy reporting of error messages
in JSPs

L "
«® Redbooks 2002 B Coporaion Ry

.

Struts Example

L "
L@ HBdbDOkS © 2002 IBM Corporation M
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Str

s Example

Controller Model

-

oginForm

View

index.jsp

Servlet <_n_ Action
VA

ActionForward
"success"
"failure”

Action —H Login _ﬂ_»: Business:
¢ *

error.jsp
"failure"

[ .
! Backend 4

home.jsp
"success"

Session

L_@ HBdbDOkS © 2002 IBM Corporation

| ApplicationResources.properties

[t lacalbost 550/My Tradsfindex jsp =l o S @P S| DI
-] index.titte=Welcome to MyTrade Application
Welcome To MyTrade Application welcome.button.login=Login
global.field.username=Username
Username [userid .| global field.password =Password
Password s ¢« |error.login.nouserid=You must enter a user ID.
.. | error.login.failed=Invalid user ID/password entered.
) o error.login.exception=Exception occurred in action.
o — | # Optional header and footer for <errors/> tag.

. errors.footer=</ul>

g errors.header=<ul>
index.jsp
<%@ taglib uri="/WEB-INF/struts-html.tld} prefix="html" %>

<h1 align="center"><bean:message key="index.title"/></h1>
<html:form action="/loginAction"> !
<table> C
<tr><td><bean:message key="global.field.username"/></td>
<td><html:text property="username" size="20" maxlength="30"/></td> </tr>
<tr><td><bean:message key="global.field.password"/></td>
<td><html:password property="password" size="20" maxlength="30"/></td></tr3
</table>
<html:submit><bean:message key="welcome.button.login"/></html:submit>
<input type="reset">
</html:form>

L@ Hedbﬂﬂks © 2002 IBM Corporation

5.

¥

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation

Struts
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Configured in web.xml (Web deployment descriptor)

0 Name:
action
Q Class: —
org. apache. struts. acti on. Acti onSer vl et Initialization:
® Read struts-config
Q Initialization parameters: _
config: WVEB-INF/ struts-config.xn Action:
application: <package>. Appli cati onResources ® Fill form bean from
debug: 2 input JSP
detail: 2 = Call action class
val i date: true ® Process return

(ActionForward)

0 URL mapping: * Call output JSP
* do (or other action)

» <html:form action="/loginAction"> ==> /loginAction.do

il
L_@ HBdbDOkS © 2002 IBM Corporation &

|

ts Configuration File

struts-config.xml (in WEB-INF)
o Form beans
» symbolic name ==> class
O Action mappings for each path

»> input JSP ==>form bean ==> action class
» forward actions ==> output JSP

<?xml version="1.0" encoding="UTF-8"?>
<struts-config>
<form-beans>
<form-bean name="loginForm" type="strutscommon.LoginForm">
</form-bean>
</form-beans>
<action-mappings>
<action name="loginForm" path="/loginAction" type="strutsaction.LoginAction"
input="f/index.jsp">
<forward name="success" path="/home.jsp"></forward>

<forward name="failure" path="/error.jsp"></forward>
</action>

</action-mappings>
</struts-config>

5",
L@ Hedbﬂﬂks © 2002 IBM Corporation &

"
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o Form bean extends ActionForm

0 Properties for fields in input JSP

0 Reset method to reset field values

O Validate method to check input fields

public class LoginForm extends ActionForm {

private java.lang.String username = null;
private java.lang.String password = null;
/I getter and setter methods (not shown)

public void reset(ActionMapping mapping, HttpServletRequest request) {
username = null; password = null;

public ActionErrors validate(ActionMapping mapping, HttpServletRequest request) {
ActionErrors errors = new ActionErrors();
if (username.trim().equals(""))
errors.add("login", new ActionError("error.login.nouserid"));
return errors;

}

L "
«® Redbooks 2002 B Coporaion Ry

e

Cl

public class LoginAction extends Action {

public ActionForward perform (ActionMapping mapping, ActionForm form,
HttpServletRequest request,HttpServietResponse response) throws ... {
ActionErrors errors = ActionErrors();
ActionForward forward = ActionForward();
LoginForm loginForm = (LoginForm) form;
try {

String userID = loginForm.getUsername();
if (luserID.equals("userid")) {

errors.add("login”, new ActionError("error.login.failed")); Business

} Logic
} catch (Exception e) {
errors.add("login”, new ActionError("error.login.exception"));

if ('errors.empty()) {
saveErrors(request, errors);
}EIS;‘o{rward = mapping.findForward("failure"); Action

forward = mapping.findForward("success"); FEEG
return (forward);
}
}
l-‘.. X
L@ Hedbﬂﬂks © 2002 IBM Corporation m

e
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Struts in Application Developer

«® Redhooks

© 2002 IBM Corporation

WebSphere Studio Product Suite

» Core Java IDE
> Create Web pages
» Animate and customize

Site g
Developer |*
»
>

JSP tags

XML

JavaBean/Database Wizard
Web Services Wizards
Team Environment

based on WebSphere

Studio Workbench (Eclipse)

WebSphere Studio

Application Developer

EJB Development
J2EE Development
J2EE Deployment
Profiling

Enterprise Developer

3 : » Enterprise Connectors
Appllca'glon De_v_eloper e
Integration Edition

» Struts

>

EGL (Generator)
COBOL and PL/I

«® Redhooks

© 2002 IBM Corporation

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation
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Create Web project (and EAR project) Lol
setup o

Tailor Web project: zr_\gﬁgt
Q Import struts.jar to WEB-INF\lib VSVtI:TJts

O Import JSP tag library files (struts-xxx.tld) to WEB-INF eEbbell

0 Add JSP tag libraries in web.xml: References -> JSP Tag Libraries
» Point to imported tag libraries in WEB-INF

O Add ActionServlet in web.xml: Servlets
» Class: org.apache.struts.action.ActionServlet
» Name: action
» URL mappings: *.do
» |Initialization parameters: config, application, debug, detail, validate

» Load on startup: 2 Use a
O Create struts-config.xml skeleton file in WEB-INF sl
» config parameter of ActionServlet points to this file file

O Create ApplicationResources.properties file to a Java package
» application parameter of ActionServlet points to this file

L "
«® Redbooks 2002 B Coporaion Ry

e

To add a Struts action to the Web application:

a Create input page (HTML or JSP)
» Use JSP tag libraries
» Add texts to ApplicationResources file
> Set an action in the form

O Create output JSPs

» Use <html:errors/>to display error messages.
. . Use
O Define the form bean (JavaBean) in a Java package skeleton
» Properties from input page models
: for form
» Validate method b
. L . eans and
» Place error messages into ApplicationResources file action
0 Create action class and code the logic and error messages classes
» Place error messages into ApplicationResources file
a Edit struts-config.xml file Copy
» Add form bean to <form-beans> section zifstt?ng
> Add action to <action-mappings> section ETORS i
with action path and forward names XML file

Vg, "
L@ Hedbﬂﬂks © 2002 IBM Corporation m

e
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Search the Internet for Struts Configuration Editor
O Stand-alone editors and eclipse plugins available

Q For example:

http://wmv. i mprove-t echnol ogi es. cont al pha/ struts-config-editor/

» Associated with Struts config
files after install of plugin
Graphical view

Source view

Edit JSPs

Edit action programs

vvyYyYyywy

» Updates only in source view
* does not create any Java code

Can also use the standard
XML Editor of Workbench

«® Redhooks

& struts-config, el

<global=

G —m -

lindex.jsp JloginAction; Ihome.jsp

1

. |

| v

lerror jsp =
_>I_I

Graph |Source

© 2002 IBM Corporation

|

Easy Struts:
o Eclipse plugin

0 Associated with
Struts config
files after install

Wour strults content
Thea "ol e el N 15 e
sclsrad in o stk ponfig, =l

Action

Tra "action” ekavrrd ciecHbas an Actionfapaing ohiect that is bo beused [ proces a
meoyest for & sl ooy s-relskive ST Ths Folosing stoobubss ars definsc:

. . o et con Q0 st pet ok Fourd invshapo
O No graphical view = =#®gwms T |
0 Dialogs to create T awen | Pom Bl ]
| ol -Fo A ancke
new form beans I i bots | Do
- t
and actions in i
config file pe il [ |
» does not create —-[@ Legnocts Rl [ |
Java code Wi gikilte O b
Fomibean  Formards Iampun]supmpu-ms
Frrward subtings
hiairea | Bt | Raediact
T T —
[T Thai KR Falcar I:hmc
Emay Toul= Sooroe
sy,
k@ Redbooks ©2002 IBM Corporation

"
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Struts in Enterprise Developer

L "
«® Redbooks 2002 B Coporaion Ry

Web project with Struts support
o Struts JAR file, tag libraries, configuration file, ApplicationResources
@ Action servlet predefined

Component wizards
O Form bean skeleton
» Includes fields from input JSP, added to Struts configuration file

O Action class skeleton with action mappings
» Perform method and action forwards, added to Struts configuration file

a JSP skeletons with Struts tag libraries

Struts configuration file editor

Graphical design tool
O Graphical view of Struts application
O Define components from graphical view (JSPs, actions)

L "
L@ HBdbDOkS © 2002 IBM Corporation M
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Web Project with Struts Support

Define the Web Project

Create a Web Project

=

(Z# Java Source

Project name: I ItsoMyTradewWeb

¥ Use default

e project acation: | d\WSEDworkspace] Iksoly TradeWeb

Browse... N

=8 Weh Content

= 12EE Weh Project { Static Web Project
Description:

== theme

B3 WEB-INF

In a JZEE ‘Web Project you will be able to create content served by a traditional ;I

HTTP server {HTML, JavaScript, images, text..) as well as content to be served
by a J2EE Application Serwer (Servlets, JSPs, EJBs..)

‘Web Project features:

Description:

B b

Add Struts support
O create a default .cvsignore file
Create a defaul C55 file

O nclude Tag Libraries for accessing JSLI

& | | Select this feature ta have support
for Struts added ta your project

Hl

Struts Settings
Sellct the initial settings for Struts

‘Wweb Deployment Descripkor

EE skrutscommon

ApplicationResources, properties <—

=z META-INF
------ {5 MANIFEST MF

L [§) Master.css

B2 classes
i El-{z= strutscommon

ApplicationResources, properties

[ Create aResource Bundle for the Struts Project

Java package:

strutscommon

(=i, Libraries

il

X
“

struts,jar <—

------ [H] ibrm-web-brd. xmi
[H] ibrn-web-gst xmi
H] struts-bean.td

skruts-config.xml

e [create aweb Profect ] B [#] struts-htrl Hd

E@ ------ [¥] struts-logic.tld

[H] struts-template. Hd

web,

R =

Browse...

Resaurce bundle "dlacs” name: [ ApplcationResaurces

< Back, |

et = | Erieh |

coneel |

«® Redhooks

© 2002 IBM Corporation

ActionServlet

Form Bean Wizard

New ActionForm Class

Specify name and package for the new ActionForm class, Indicate any modifiers,
interfaces, or methods to be generated,

%

=

o JSP field

Folder: [ itsontyTradewebylava Source

Java package: | strutscommon

Browse. .. I
Browse. .. |

ActionForm class nam4 LoginFori )

Browse. .. I

Superclass: I org.apache. struts, action. ActionForm
Modifiers: ¥ public [~ abstract [ final
Interfaces:

[V inherited abstract methods
¥ constructars From superclass
¥ reset{..., HttpServistRequest)

Method stubs:
[ reset{..., ServletRequest)

|| |Struts con

P Generated code includes:

S

» with getter/setter methods
0O Reset method
O Validate method skeleton

Form bean added to

figuration file

Remove I

A Field, getter, and setter will be created For each item you choose

New ActionForm Class

Choose new accessors for your ActionForm class

¥ validated..., HitpSeryletRequest)
™ validatel,.., ServietRequest)

Code Generation Model: IGeneric ActionForm

Choose Accessors:

SRR :
#l-- [ f| home.jsp
=k & index.jsp
1 &7 [WEB-INFfstruts-html.Hd
1 & MWEB-INFistruts-bean tid
[ &7 theme/Master.css

I U text : username
M 1 password ¢ password

«® Redhooks

© 2002 IBM Corporation

Las Vegas, Nov 11-15, 2002

© 2002 IBM Corporation
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Action Class Wizard

g@. Generated code includes:

New Action Class

Specify name and package For the new Action class, Indicate any modifiers,
interfaces, or methods to be generated,

Folder; [ ittsotty TradewetiJava Source

Browse. ..

Java package: I strutsaction

Ackion class namely LoginAction )

Action class added to

[V inherited abstract methods

™ constructors from superclass

o Perform method skeleton
O Setting the action forward

Superclass: I org.apache.struks. ackion, Action Browse... St r u ts C 0 nfi u rati o n fi | e
Modifiers: I public I abstract [ final g
New Action Class |
Interfaces:
Create a mapping for your Action class
Specify the configuration file, path, forwards, and form bean For your Action's E@
mapping
¥ performi..., HitpServietRequest, HitpServistResponse)
™ performi..., ServlstRequest, ServietResponse) ¥ Add new mapping:
Methad stubs:

Code Generation Model: IGeneric Action Class

«® Redhooks

Configuration File Mame: |WEE-INF/strubs-config.xml j
Mapping Path: floginaction )
Mame [ path |
suCcess [fhome. jsp Add...
Forwards: Failure [inde:, jsp
Remove |

Form Bean Name: ‘Ing\nFnrm ’ |

<Back | weds | Ensh |

cancel |

[]
L

© 2002 IBM Corporation

New ISP File

Specify & name and location for the new JSF File,

)
@ Generated code includes:

O Struts tag libraries

Folder: | itscity Tradewieh treh Cantent

Browise... I

File Kame: I index.jsp

complete the JSP

Markup Language: IHTML
I™ Create as 15P Fragment

I | Wse ¥ML Style Syrkax
New ISP File

Select any Tag Libraries you want ko be included in the generated page. @
Code Generation Madel{ | struts 5P

=l

Use Struts custom tags to

New JSP File

Description:

Choose any additional Tag Libraries you want ko import

Create a new Struts ISP,

| Add Tag Library, .. I

Available Custom Tags:

|
| JWVEB-THF{struts-html. tl
bean .t

Remove I

Tag [ Description

cookie
define
header
include:
message
page
parameter
resource
4]

«® Redhooks

P

© 2002 IBM Corporation
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JSP Editor: Page Designer

Page Designer supports custom tag libraries: ‘
Q JSP ->Insert Custom

» html ->form
Tag libraries in document: Custom kags in selected tag library:
» html -> text, password
) LRI | Prefix | | Infarmation | -
» html -> submit JPWEB-INF/struts-html.tid  html
TWEB-INF/struks-bean.tid  bean
> bean -> message | |
L
=
add | perovel lnsertl

<Hl><bean: nessage key="index.title" /></Hl>
<htm :form action="/1ogi n">
<bean: nessage key=" ggl obal . fiel d.usernane" />
<htm : text property="usernane"></htmnl:text>
<bean: nessage key="gl obal . fi el d. password" />
<ht m : password property="password"></htm : passwor d>
<htm : subm t >
<bean: nessage key="wel cone. button. | ogin" />
</htm : submt>
</htm :forne

L@ Redbooks ©2002 IBM Corporation : -

£

Action Path ] Action Attributes ]
logindction @ Type: Istrutsaction.LoginAction Browsel Edit |
" Forward: |
—  Include: I
Configuration editor e [ndex.sp
. P ter:
D ACtIOnS ‘arameter I
i Default: r
> ClaSS, Input JSP, Specify a Form Bean
form bean, forwards Form Bean Name: | loginForm =l
0 Form beans Scape: | [
Attribute: |
O Global forwards :
Walidate: IDeFauIt j L=
o Data sources — [
Suffiz: I
Can edit the XML Specify Forwards
2 Mare | Path | M
source directly Jnome. Lo |
Failure findex.jsp Mo_difyl
I Delete |
Hew | Deletel i
Actions ] Form Beans | Global Forwards | Data Sources | ML Source
L "
«® Redhbooks 200218 Coporatin ey
i
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Struts Graphical Design Tool

Web Diagram Editor

O Double-click on new
components
» Wizard to define new
component (JSP, action)
@ Double-click on realized
components
» JSP editor

O Each node has path and
description

o Connections have action
forward names

O Icons to add components =
and connections <3:(> [:3' il U 31}‘3.

» Struts configuration editor

8 Login, phi e I / /

index. ]s%ﬁ//vh.me Jsp

«® Redhooks

errnr.isp
-
4 2

© 2002 IBM Corporation

updateAccount DI ag ram S C an
™ =, be tailored
account. acct@ jsp o LayOUt Of
ﬁ components
|ndex ) Iogout\ Q Con neCtIOI”IS

|ndex S

/ome

Iogln

3

register.jsp register

A

; 2

portfollo portfollo jsp
Diagram editor is
coupled with Struts

/ configuration file

seII
e
;lJ

«® Redhooks

L "
© 2002 IBM Corporation M

L]
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User Coding

JSPs Real business logic
@ Layout using Struts custom tags in JavaBeans (EJBs)
Form bean that are <_:a||ed from
. . the action class
0 validate logic

if (usernane.trin().equals(""))

errors.add("l ogi n", new Action “error.login. nouser"));

Action class

a perform logic
try {

String userlD = | ogi nForm get User nane() ;
if (luserlD. equal s("userid")) {

errors.add("login", new ActionError("error.xxx"));

} catch (Exception e) {

errors.add("l ogin", new ActionError("error.yyy"));
}

«® Redhooks

L "
612002 8 Corporaton Qi

Enterprise Generation Language (EGL)

o Future replacement/migration path for VisualAge Generator
» Environment independent language
O High-level programming specification
» Generates Java for Windows and z/OS UNIX
» Generates COBOL for z/OS CICS transactions
o EGL parts
» Programs and functions (4GL)
» ltems, structures, records (including SQL)
» Control parts (build descriptors, linkage options)
0 Iterative development and test
> built-in EGL debugger

O Code generation with distributed build processors

Can generate Struts actions business logic using EGL
o Call through Java wrapper or session EJB (generated from EGL)

«® Redhooks

=g, "
2002 8M Crporaton Em—r—y

e

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation
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ActionServlet y°°°"c°°*° | LoginAction Busess
Login LoginEJB I LoginClient I LoginCobol I
Java wrapper Java wrapper Java wrapper

N 77 ]

J2C Connector

session EJB %%

to z/OS CICS

/ 3

=
COBOL Prog Database
Q@ HEdbDOKS © 2002 IBM Corporation m

Testing of Struts Applications

Enterprise Developer includes WebSphere Application Server
@ Version 4 server for J2EE 1.2
o Version 5 server for J2EE 1.3 or 1.2

Process: Developer Test Deploy
a Define a server Machine Machine
o Configure the server with
data sources @
o Assign projects to server
o Start server WebSphere WebSphere

V5, V4 V5, V.
> normal or debug mode built-in \ 1

a Ruh project . App App
o Universal test client for

EJBs and Web services \ start

WSED ’A%ent Controller

=g, ,
Q@ Hedbﬂﬂks © 2002 I1BM Corporation M

Las Vegas, Nov 11-15, 2002 © 2002 IBM Corporation
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Deployment to WebSphere

Configure WebSphere with Admin Console
o JDBC drivers and Data sources WSED

Export application as EAR file
a Contains Web and EJB modules
O Web module contains Struts support EAR File
a Optionally tailor EAR with AAT

Install EAR file with Admin Console
o Configure JNDI names WebSphere
a Configure EJB references

export

install

_ stop | start
o Do not redeploy EJBs (code is generated)
a Configure J2C connector Test
Stop/start server and test +

L "
«® Redbooks 2002 B Coporaion Ry

.

Summary

Struts helps to implement model-view-controller architecture
o One servlet

o View implemented using JSPs o o
) ) : : Legacy Modernization
a Action classes to link to business logic with WebSphere Studio
Struts in Application Developer Enterprise Developer
o Manual work B gt

a Some eclipse plug-ins available

Struts support in Enterprise Developer
O Web projects with Struts support built-in
O Wizards
O Graphical editor
O Enterprise Generation Language

Redbook: SG24-680% Legacy Modernization with
WebSphere Studio Enterprise Developer

L "
L@ HBdbDOkS © 2002 IBM Corporation M

™
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THE END

Redhooks

International Technical Support Organization

ibm.com/redbooks

Las Vegas, Nov 11-15, 2002
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WebSphere Studio Enterprise Developer -

Enterprise Generation Language (EGL) and
Struts Technical Overview

Jan 2003

Reginaldo Barosa

Certified IT Specialist
1BM Boston

rbarosa@us.ibm.com

IBM Software Group

WebSphere Studio Enterprise Developer V5.0

= Struts Tools

> Set of Wizards, editors, and validation support
»for the design and construction of Struts-based J2EE web applications
= Enterprise Generation Language (EGL)
»Simple, high level programming specifications
»for creating full-function COBOL and Java applications
= 7/OS Application Development Tools

» Interactive, workstation-based development
»for mainframe COBOL, PL/I, ASM applications

= XML Enablement Enhancements for z/OS applications
»Set of wizards to create XML transformation code

»and web services for XML-enabled z/OS applications
nsoftware




Extending the Enterprise to the Web

WSED
Sample
Application

Native
Java
Logic

= Comprehensive end-to-end development environment
>Build large-scale, dynamic web applications and services
>that leverage heterogeneous technologies and skill sets

= Speeds developers through the entire development process

Examples:

* RAD

EGL
generated
Java

Logic

z/0S

Native

—pO O4—» ccs

isps [P struts

EGL
O ol = — generated
Connectors COBOL
WebSphere Logic

ebShere software

Connectors Logic

* Combine middle-tier (web) and host logic
e Web Services for COBOL applications
¢ Reuse legacy applications

[hnf]
Il
i

LT}

1l
ol
14

Extending the Enterprise to the Web

The nisxt table shows the vahlid calls o or from the ECLgemerated code.

Calling phject

Called ohject

An EGL-genaratod Javn weappor claks :n a
I2EE applicaziom client {a potential starting,
g At Ened

An EGL-geoerabed Java peogram

Adv FGL-poverabisd EJB sesson bean

An EGL-enwerabed CICS COBOL program

An EGL-generated Java wrapper class i a
IZEE wely application & poteritasl skarting
point at run bme)

A EGL-genemted lva program

An EGL-penwrated Bl session bean

An BGL-ganermbed CICS DOBOL program

An BGL-gemerated FJH seesiom bean

A FGL-gevwrabad Java peogram

A BGE-genweriabed CICS DOBOL program

ebShere software

[l
Il
i

LT}
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1




Key Benefits of Enterprise Developer

= Struts Tools
»Rapid design and quicker understanding of complex web applications
»Faster development with less errors of well-structured web applications

= Enterprise Generation Language
»Rapid development
»Cross platform applications (CICS, WebSphere Application Server)
»Using existing programmers with traditional business skills
= z/OS Application Development
»Extends benefits of WebSphere Studio Workbench features/tools to
COBOL, PL/l, ASM programmers
»and the z/OS applications they create and maintain
= XML Enablement Enhancements for z/OS applications
»Faster development of XML-enabled z/OS applications
and of supporting Web Services

ebShere software

[hnf]
[
i
LT}

1k
ol
14

WebSphere software

I

Struts Tools




= Rapid design and construction of J2EE web applications
»Promotes well-structured web applications
»Enables development in less time with fewer errors

»Connects to business logic of choice
= EJBs and Java classes
- COBOL, PL/I, EGL programs

= \Wizards and editors

»Setup J2EE web project with Struts support
»Create Struts components
» Struts configuration file editor
»Web diagram editor
- Visual design and assembly of web applications
= Build Support
»Validates changes against existing resources and identifies errors

ebShere software

[hnf]
[
i
LT}

Why Model-View-Controller 2?

From monolithic :> To well-structured

MVC 2
JSP
H
Model T | i
View T \ @ = [
Controller P Ner Rg — counr Fm
: @ i
v f | Isp |/ 9 ‘
\J S \el View Controller lil H| ‘ ”|
. |
Model
View
Controller
MVC value:

® applications are more adaptable to change
* e-business apps are more maintainable

® Reduces technical expertise required

® Includes all developer roles in process

ebShere software

[l
[yl
i
LT}
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Browser

HTML

page
(form)

HTML
page

(result) e

ebShere software

compiled

JSP

[hnf]
(il
i
LT}

1k
ol
14

Browser

HTTP Server

HTML

page
with
Form

ebShere software

Application

Server

/
Command

Beans

Beans

other

[l
(il
i
LT}

1k
wll|
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Controller

]
Action <
]
ActionServlet Action |-g—p|
. l Model
- ActionForm Action |=t—
configuration I
file Action -
]
software Egig

1k
ol
14

Struts Action Form Handling

ActionServlet

Action

<<instantia&

ebShere software

ActionForm

+ validate()

L

+ perform()

‘A»

[l
[yl
i
LT}
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wll|
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Struts Request Sequence

R

- Web user |2 ActionServlet : Action : ActionForm : JSP
(Browser)

o
TP setXxx() >D validate()

perform() >

B forward() ! v -

o
X
&
X

L

{

i
L]

ebShere software

[l
|

1l
ol
14

Struts Configuration

Configurations

Sinus includes a servlet that implements the primary funclion of mapping a
request URI to an action class. Thersfore, your primary responsibilties relstad to
the controller are:

= Write an action class for each logical request that may be received (extand
arg.apache, action, Action),

= Configure an aclion mapping (in XML) fsr each logical request that may be
aubmilted. The XML configuration file is usually named s Eruts-config. aol.

I »  Updabe the Web application deployrnent deseriptor il [in X0L) ko your
application o include the Necessany Sinds companants.

= Add the appropriate Struts components to your sppication

ebShere software




Custom tags
There are four JEP tag libraries that Struts inchedes:

2

1.

- The template tag library for producing and using common JSP lemplates in

The HTML tag library, which includes tags for describing dynamic pages,
aspecially forms.

The beang tag library, which provides addiienal tags e providing Emproved
access o Java beans and adddional support foor internatonalzaton,

The logic tag library, which provides tags that support conditional esecution
and looping

madtiple pages,

Using these custom tags, the Struis framework can automatically populate fields
from and to & form baan, raising we advantagss:

*  The anly thing most J3Ps nead to know 2bout the rest of the framewaork is the
proper field mames and where lo submit the form. The asscciabed form bean
automatically recsives tha comesponding value

= If a bean is present in the appropriabs

walidation routine, the ioerm fields wil be awlomatically initialzed wilh the

matchang proparty values.

Therefore, an input field declarad n a JSP wsing Java code as:

=input types"text® names® fiame® value="=t= bean.getFirstan={) ="=

can be replaced by a more elegant and efficent Struts fag:

=htnl i text property="flane® =

ebShere software

soope, for mstance after an input

Example: Creating St

uts Application

e
Dol thai: Wl Prin et Sed the Erdeipr e App ki on projec settings, contest ook, and LEEE leved,

Crastn &b Project
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N v s st ey | VLT i 155 Db st T ki i
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Doscn phion;
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D sz ipiont
j Select this Festurs i heye o nr

Sk ks madEd Lo o pra L
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B L bt

T e e s | DU T v o o Tra e .:1:..1.'.—1
cu'wd:rm:l MyTrack i
HEE Lewel |13 -

Lamrpbon:

X2EE Ll 1.3 Ind udes & Sandel Spedlcation keval af &5 and & 15P Spacficanion kvl :I

of 1 2. Appl cetions devs loped For this I20T vl bopaaly barpat o MW varsim 5.0
E
=

CHud st = I Brih |
|

< fack Wik =

T USEESIIEES SUTWATT




Gheats Setting s
Sedact the indi ol sedfings for Struls

W Cremrmice defsok s tirge

g

|
ok Jﬂ\upa‘.ha]k

P Crastea P Bundka for the Sruts Promct
LT
v pachage
Plscar e burdde names: | AopboatorAmsounoss

| skrubscormimen

0 =— — O
—a =
] Wizh D plasmeent Descriptor
o2 laraa Soufos
(SN T
=] #pplicaboniesn i procer thae
(=8 Wt Canberd
- HETAIWF
T MaFEST M
[ thars
.m Hastar.can
(e WED-[NF
= i dommen
H - stk soonemon
[ Fopkationfim sour oo, proest e
Bigr b
= stk e
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¥] smuez-conbig vl
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®] stks-lgictd
o] stouts-bainplate ki
98 meboml
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g it

E
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TOTOIVTIS

et

¥ e

# Elmﬂ.ﬂ'rm

=11 sk Tradeieh
= Java Siuos
- stniteackon
—}- = slrubscnman
o)
4
== Web Carkent
=i [ META-INF
& nnFEsTIF
£ thenes

GAEE]

x|

loeme bubten. lsgin=Lagin

lebal. Bield. uSarmans =5 o rnar
1¢bal.field, paspwerd=Fasaword
eryor.login. nouaerl &You moat enter
error.loegin. failed=Invalid ue=r I a

imdex. titla=Kalsaems to WyTrade Applisaticn

a ozer ID.
n4d/+r papowerd entered

{3 {7
H=rrere . hesder=—nl>
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Example: Web deployment descriptor...

[T o

L5 EE baregelor
(=i [Ty Tra e

5] wab Dol e Daso poor
8 1=y Soume
B (g b Conterd

i META-IF

(e Kt

f

<o
s

T

[ sty uka-temg

= _Ll.:ra_l e

Serviets and 15Ps

Sapylets and 1aPs

The folmwing servists and T are rchuced in this weh
application:

| BT R RS,

o [betalls

Dt of twe smbsctec oervlet or 159

e [ e T |||m
L
bt [ ]

= LBL Mappings

The follesna URLS & & mapaed oo this sersiet

T

L

Tha Folkewing it skeation paramabars are conf e For thar

Sereint:
e v |
config SWEB-INFsruks-ronfi.,
b 2
cetell 1
vl ks
Rammvn =prstin stk scommon AppkostL

frtn Licconers | Sacualy | Emranment |Reforen s |Pagis | Paranisters [ MIME |Extareions (Soete

Bl o T

Example: Adding

e 9P Flke

JSPs to Appl (index.jsp)...

.
Spedy & nane and [ocstion For the res J50 Fis, |mmﬁ|n
el ect are T Libr snemyooywart b ba ncl_rded in e generated cag e,
Podder: | Mescby TracdetthebWieh Cordent =M
Chaoem arer ncdt ional Tap Libranes youseant b import
Pl i | Tiredens el i Rkt [T oo T=gLbvery |
A hind JEE-FFsh ukshiml i d l
Hatkup Languaga: |HTM. =] —
T Create o 150 Fragresdt
T~ 13b= o Sryl= it
Coce Garerabion Nul{: Fotribs 150 i 1| 1 i
Bvalahle Cuon Tags:
Dmecriphion: B
Crodta a nan Strats P, 1= L Dez=rption =
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defie
trezscies
nduds
=
pag=
paramater
resorTe
ik i
=inuts hd
1 1 ]
oot | s [T ce
< pack Perat = Erth Canenl
TSR software




ey FEF File
# P e Lo anket thee page direcise informatkn,

Pagm Diractkve Informatione
I oot 5 Pace Divsd i

miw ISP Rl

Speriy cphiom bka encocing, conberd byee, documert by ps and skl sheet
infonration bo bes inaleded in e Qen ersbed pags.

' [Le woskbenth defsul] wiorkhenchEncoding ; [ WINDOWS-LE5E

W tngusge [T

-

ook 1y

Irapert e Soneent Typei | baat /bl
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Example: Adding JSPs to Appl (index.jsp)...

Faapn Field Selection
[ — IF deirec, emdact Morin b el bo ncudk inoa for in Ehea new 150,
T hiocen reathod shobs bo genecs e ard infor na bor (o be sdded ko the E
D Teank dexripbar.
i ] 5
Wch i ebced Foobes o v B DO CPARET
el T dastringl) ooy | Bt i
™ add o web,am
SoeddMane: | rder B0
Tritakea o Wk
A
Ink Papaincioes: e
UL Patbarn i Fiakh
Mredzi b =]
3 i
IR e o |
A R Brich Carar==T




d =

L T B g e e e e Bl

T
hrak=®thams Haskar , znat relelsbylaghast! typesd ket cmniie
En
< JIRADI
| Add this code between <BODY: and «/BOLY:
1=
L align="cantar"><hear: Maasage Kar="index, tltla"/>2 /Rl

v actian=® fleginketlont=

o of

otE=
“hdrtbaanrmassagea kay="global field wearname" =) Lar
taxt property="nTernane® 91Te="20° maxlengins® 30 <) Cds

= kay="glokal . field pamesra = kA
£ Profpartysipasauwerad’ slEastan! nawlangth=ra0f S e

LraEtag s Eey="welooms otton, Leglan® /=

>k

ebShere software

| eony = s
i

Welcome To MyTrade Application

Vo st coqeect e folowing error(a) before proceedmg N\ )

+ Fust eror mesdape

# Becond etrar message

# Thrd emor message

Perrors headar=<ul=
berrore. foskar=x/ulr

ebShere software

Tar.login. nouserid=Yen maet anktar a2 ugar ID
arrsr.lagin.failed=Irealld uasr ID

¥ Opticnal hasder and foskar Ior =erroref> tag.

afdfer pagEword antarad
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Example: Adding actionForm to Ap
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Chinee: new acoesenss (e wous SotionFeem clasc
A fizkd, getter, and setter vl be o eated For mach e pou chooss:

W—
FOE o,
= EE e
= B roontcon
B et 1w rame
: B0 passand | password
i | g EE S [ . o
= Dl bl TradeTutorid 1= aolrectedt =l 2
& T oMy TradelaR: ackEmnm sbrubscommen;
= Ry Tradetsh ; :
4% 'Wnty Despiowrent Descriphor impork javes.sscvlst . bbep 0t
4 . : import org.spacha.strante, a0t
: import org.apache gtrota.act
A import org.epache.etrute.act
Just click Finish i x
“hocar A cassora: 4“’_\””%": * Form bean for & SLCUca apg
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TEE Mavioptor | Sapear Corfigustion private java.lanyg.Scring
| orivata §avae.lans.String
& Babery = Il al
T software

Example: Adding actionForm to

Appl...

package strutscommon;

M import statements not shown

public class LoginForm extends ActionForm |
private java.lang.5tring wsername = null;
private java.lamg.String password = null;
S/ getter and setter for username and password ......
{f constructor ...... not shown
usernamz = null;
password = null;

i
public ActionErvors validate (ActionMapping mapping,

ActionErrors errors = new ActionErvors();

S/ validate the Tialds in your Torm,

J// adding to this.errors as errors are found, e.g.
A0 4f ((field == nul1) || (field.length{) == Q)) [
I
b

return errors;

]

public void reset{ActionMapping mapping, HttpServietRequest request) {

HitpServietRequest request) |

errors.add("field®, new ActionError("error.field. required"));

not shown

Figure 6-15 Generafed code for the LoginForm ciass (abbreviated)

[
||I||l||




Example: Results of adding actionForm ...

o | |
Bazn flama Form Bean dkribukes
_ Teopes: |mmm Logni orm n‘umi 418
Spexily Form BEan Mapping Ecisreions
Claastama: | Bmm! _IE‘"
| Prapes L usiue e
e
il ] 1L
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Dépi by M |
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BT ]
=LA QAT T

<fduta-mour cear

Form Jasnm

= OTE

I s

AT

| ana=ilaginform® typas s etrutoscimas. LeginForn>

Example: Adding LoainAction class to Appl...
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Example: Customizing LoginAction class ...
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Example: Adding action mappings to Appl...

Action mappings

Sofar we have added J5Ps, acfion forms, and aclions to our basic Stuis
application. We have added action foreards and action enmors 1o owr action. We
will now lie all Bhose pleces ogether using action mappings to complets the legin

portion of our applicaton
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Completing Login action ...
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Example: Testing the Appl...
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Example: Testing the Appl...
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Example: Test again.. user ID empty..
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Our samgple Wab applcalion has a simple fow:

= A owelcome page & displayed indially

= A owser can enter a usar ID and a password on the walcoma page and click
Subni

=  The server invokes a Skruls adlion class fo werty the user D and password

= |f the authentication & successhul, the user can procesd to the homs page of
the: application

= |f the authentication tais, an emor page is shown and the user can go back 10
the walcoma page

To implamant this Web application we use the Struts application diagram aditor, |
from which we can implement the J5Ps ard the achion
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Just double click on formBean....
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forward = mapping . ZindPervar i walidt);

Eavare cohal Fonaarck | Duta Soueces | 2L Soe e
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Example2 : Testing

e+

[range ghaidl wo: 0] v el e’

Aalcaaes I

e [Weerid other

Welcome To MyTrade Application

Pamwa:dw
\
____d
*\ualiu v Imi"\
) Welcome To MyTrade Krror Page
Home Page e [T s fuvaaticl
Weloume Page

must enter userid and password

ebShere software
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Struts Sample Application

= Struts is an open source implementation of MVC2
= Struts Tools enable faster development with less errors

View Flow Control Form Action Business
Beans Classes Logic
Welcome Portf io 1
ISP Portfolio
Y —1
Home Log . 1
ISP Login
A 0 ——
B Portfoli
ortfolio ervle Quol 1
ISP Quote
Quote AGEE 4
ISP Account

Struts Config File
> Action Class
» Form Bean

ebShere software <JSP

./: Struts Tool support

VG Web Transaction today

VG Web Transactions (simplified)

The User enters data on a JSP

form and presses “Submit” .
button Session

The VAGen Gateway Servlet
places relevant data in an input Ul
record and passes it to the
appropriate Web transaction for

processing !
VAGen Web Transaction
The Web transaction performs its Gateway Serviet
“action” and returns an output Ul &P
- record which includes “where to
go next” .4[.

The VAGen Gateway Servlet takes
the Ul record, places its datain a

Ul bean and calls the appropriate

JSP

The JSP uses the data stored in
the Ul bean to populate it's own

fields and the process repeats
IS an software




The User enters data on a JSP
form and presses “Submit”
button

The Action Servlet checks the
struts-config.xml file to determine
which action should be invoked

It then takes the JSP’s form data,
places it in a formbean and invokes
the appropriate action, passing the
form bean

The Action takes the data from
the formbean and performs its
‘action’ (updating other beans as
needed)

The Action may place a formbean
in the session, and sends a
“forward” to the Action Servlet

which invokes the next appropriate

JSP (or Action, as needed)
The JSP uses the data stored in

the formbean to populate it's own
fields and the process repeats

ebShere software

Session

Action Servlet

Action

y

struts -config
(-xml)

uts and VG Web Transactions

VG Web
Transactions . \
Session
VAGen Web
> Gateway Serviet Transaction
Struts
Applications Session
Action Servlet Action
JspP

L ©
1

Struts
config
(xml)

ivebsphere B

Struts Applications and Web Transactions are
actually very similar:

JSPs for Views

Beans hold data for JSP usage
Specialized Servlet Controller
Struts Actions fairly analogous to Web Transactions

/

Session
Action Servlet Struts Action
= (replaces VG (wrapsVG web
p| Gat Serviet) transaction)
Struts
config
(xml)

WSED

Replace VAGen Gateway Servlet with Struts Action
Servlet

Make Ul record a subclass of formbean

Wrap Web Transactions within Actions




Web Transaction in WSED Summary

ul -
[II]

EGL

VA Gen:

WSED:

|

|
.

Problem: Once JSP is “beautified”,

regeneration “spoils” it.

ul
uum

Solution: Don’t generate JSP...generate
T softwa Ul Record from special “tags” in JSP
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Visual design using yellow sticky notes

Some general links
to our public stuff
and external sites

of partners Login
components for
Employee site
TSR software

New We'll deal with
Account this path later
Brokerage

Password

Goto C:}

(list)
Account
Details
Research
Trading

% Want to reuse

Details
Holdings
Portfolio

value.

Account

etc

w Service
differentiation

* Gold Customer
get real time quote

Quote
Results

L

X Silver gets

delayed quote

Trading

Buy / sell
from holdin

y - Results

Trading

Trade confirmation
Holding updated
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i
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Web Diagram Editor

= Design

»Add web pages, actions
»> Define application flow

= Create

| D
_

s LevE Tite i vy e

> \Web pages: JSP, HTML
> Actions:

Java, COBOL, EGL

=B

Benefit: Faster construction of web applications

ebShere software

[hnf]
(el
i

= End-to-end Debugging
> Java and JSP debugger
»COBOL, PL/I debugger T T T TR |
L Bl Jassic WM
» EGL debugger

S Fystem Theaad [Fnstzer] (Rurming)
= Verifying application Flow

= profac ina: 14 [prafac]

-8, System Thraad [5ional depatcher] (Rurnr
— Wy Thread [profac] [Suspended (breskpoint

= profac manShing [J] e 353 A
. S Fwstem Theaad [Referenca Hander] Funi
» breakpoints M P e
-'l—j__ = e
» changing variable values | Elroiced X TR ‘i B= Oute
select (pyofiless. actiond } A outhe & not &y
case [ ‘zmlept]:

= \WebSphere Test Environment

> integrated in Workbench

afac-inguirg|j:

prof ac-updatarl ] ;
cEss [ agd”

profac—sdd(y;
end: 1]

SFEDTiph
el

> choice of versions

al

Benefit: End-to-end test and debug from the Workbench

ebShere software
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Building and Deploying

= Automated Build based on Build Plans (XML)
= Automatic transfer to target machine
= Run build commands on target machine

NT Client TCPIP
Socket NT
Build
Java Plan
1 TCP/IP
= Build comman @l> AIX
; Build
COBOI Build Command [Build command
Plan
H PL/I IHOEESEer Build command
5 < TCPIIP
SockeQ uss
Build
EGL Plan
Source XML Java W
ANT Command Socket TSO
Make Objects
Scripts

Benefit: Developer spends less time in the build process
—software
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Functions planned* for GA release

= Enhancements - usability, function, ...
»Struts
= Simplified definition for the non-Java programmer
»EGL
= Web Transaction support
= generation of Web Services interface
»z/0S Application Development
- Code Assist for COBOL, PL/I
= \WSAD-IE dependencies
- »new Web Service for XML enabled z/OS applications
= for XML pass through support
»JCA connectors
= for Struts to communicate to z/OS programs (EGL, COBOL)
—for Web Service to connect to z/OS Driver Transaction
* Not all planned functions may make GA release
software

[l
[yl
i
LT}

1k
wll|
1




Functions planned* for GA release

= Enhancements - usability, function, ...
> Struts
= Simplified definition for the non-Java programmer
»EGL
= Web Transaction support
=generation of Web Services interface
»z/0S Application Development
- Code Assist for COBOL, PLII

= \WSAD-IE dependencies
»new Web Service for XML enabled z/OS applications
= for XML pass through support
»JCA connectors

= for Struts to communicate to z/OS programs (EGL, COBOL)
—for Web Service to connect to z/OS Driver Transaction

* Not all planned functions may make GA release

ebShere software
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Differences from VisualAge products

= VisualAge products bundled with WSED shipment

= \VA COBOL
»Some of VACOBOL function installed with WSED
»Must install VACOBOL product for:
= Data Assistant
—BMS Map Editor
= Performance Analyzer
= VisualAge Generator

»No migration support for 4GL to EGL until 2H/2003
»Must install VAGenerator for:

=IMS DB/DC, 3270/5250 Text, Web Transactions

- Templates

ebShere software
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WebSphere software

it s mofiwane

WebSphere Studio Enterprise Developer V5.0

z/OS Application Development

Jan 2003

Reginaldo Barosa

Certified IT Specialist
1BM Boston

IBM Software Group b Qusib
roarosa@us.iom.com

WebSphere Studio Enterprise Developer V5.0

= Struts Tools

> Set of Wizards, editors, and validation support

»for the design and construction of Struts-based J2EE web applications
= Enterprise Generation Language (EGL)

»Simple, high level programming specifications

»for creating full-function COBOL and Java applications
= 7/0S Application Development Tools

»Interactive, workstation-based development

»for mainframe COBOL, PL/I, ASM applications
= XML Enablement Enhancements for z/OS applications

> Set of wizards to create XML transformation code

»and web services for XML-enabled z/OS applications

software ?;f—?—f




Key Benefits of Enterprise Developer

= Struts Tools

»Rapid design and quicker understanding of complex web applications
> Faster development with less errors of well-structured web applications

= Enterprise Generation Language
»Rapid development

»Cross platform applications (CICS, WebSphere Application Server)

= z/OS Application Development

COBOL, PL/l, ASM programmers
»and the z/OS applications they create and maintain

—*lcingexisting-programmers-with-traditierat-business skills————

»Extends benefits of WebSphere Studio Workbench features/tools to

= XML Enablement Enhancements for z/OS applications

»Faster development of XML-enabled z/OS applications
and of supporting Web Services

ebS Al software

ISPF based development - Old
jj(bmit compile job —= Swap to SDSF__

=01y

fl= Ect Ve Communcstion - Gchons | Windows  Hep

exit source

change code oy williann

ebShere software

find code line ~-—Cedit source exit JCL

select job

find error msg

'

¥ find code line
&4 (remember

error)

'

| swap to edit

session

¥




WorkFrame
based
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Separate
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window

Edit
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WebSphere Studio Workbench - New

edit source

Statement

= oS Projeckn w3 || | [ ikekome

in error

=1 steu-cemoees [0 8
3 STEN.COA0L

] O H T
] DFHOCSTC
w] KR i

mm-lrsmiizl

000100
|

PLY "URETHING
FERFORN H1ODO-CALL.
IF TEST-STATUS = “F"

DISFLAY "“wsssss CALTIVPL 'S-LECESE

TGP TS O was el 34,

TSN TP, il

Outline view presents
COBOL structure

double click on

the error

Error list in Tasks view

Benefit: Simplified development for COBOL and PL/I on a common

development environment




Same Debug— -l R Il
e S

Perspective

T emnsteds <urknens y [

5 o State: Cengine beninateds Connectan: l.'l:lmmE o Pt BOC1

& SHETR] @ %5 et v [l [ 0] 1]
:
2 WILDLOPELID =] For 3 ST N Y el B .J‘,'ws-ﬂ,:-:luua
e el e || @ 3
i Em_.;._,n_uflmm a0 oy o TEST-STAT =
B rLoymE0z moe EE Eg EE o Shalu: oangina berminabad > Connecton: 05 <
B eLawm G0 s 0 Tl 0 - t}gﬁ.h‘nm.dﬂumacmm.ﬂpﬁ.
L s |1 G Shabm: stebopped® Cormackiore Q5900 95,31
Eum Hiw L =y Thraad:L {Funrabla)
-F.l!'-'b. = ATy L = CALNPLiOL
m—f’”’?’"‘."‘“’ Caen I Frocees: STIZERAT Frogram; CALLDPL ¥
pen it H | |
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(ERN  EYEC Pen-m P W £ [
" Row 5% Colu i |
AT F—i—— i G
aoansd 24 " &
0oneE 25 DISPLAY “ssssx START OF CALLIVPL 4
oooosE @&

Benefit: Consistent debugging environment for COBOL, PL/I, Java

Benefits of z/OS Application Development

»Simplifies development process

»Provides consistent development environment

»CICS, IMS, DB2, batch

ebShere software

= Utilizes Workbench features/tools to support COBOL, PL/I,
Assembler development for the z/OS platform

= Provides development support for traditional runtimes
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Directory

definjtions
=101=]
2/0S = ' : |
Systems\ﬁh [{5E =hin Drmtoies x| ra x II .
] it Loea Fky i T T apping of
i | cinet? beat: fol | ] b zI0S
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B = “abj banary
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z/OS

Projects Perspective
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Benefit: Developers focused on business logic and not on writing JCL

ebShere software
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Benefit: Developers do not have to continually switch between systems




SCLM Support

= Uses VCM adapter B

N s
= Access to SCLM services on z/0OS | P

> Connect to SCLM repository S |
» View a list of projects LS
» List project members 2@ DVl
E @ SOURCE
> Execute SCLM actions S R
= Check-in/check-out support o : :
-5
> TEMP WORK AREA | | ?515315 s e
_ = No SCLM administrative functions R Voo [ A e e
. B VIHT il
» Create SCLM project SR e
» Delete SCLM project NG e
. . . B wOMT  Save Fie back o Aepodon
= No automatic synchronization -‘J_T:IT.]_ bt
& Ly L P
» Manual refresh el [ouin gy :
Aepace wWith L3
—software EE:‘:?:

Building and Deploying

= Automated Build based on Build Plans (XML)
® Automatic transfer to target machine
= Run build commands on target machine

NT Client TCPIP
Socket NT
Build
Java Plan
4 — TCP/IP
= Build commanq Socket
. Build
COBO Build Command [Build command
Plan
l PL/I IFOEEsSe Build command
v TCPIIP
| Socket uss
Build

EGL Plan

Source XML Java U
ANT Command Socket TSO
Make Objects
Scripts

Benefit: Developer spends less time in the build process
nsoftware
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= [ncreases programmer productivity

»Simplified development process
»Unified development environment

= Reduces Total Cost of Ownership (TCO) by adopting a consistent

development environment for the enterprise

»Single development environment to manage and deploy vs. multiple

» Simplified training requirements

= Facilitates the building and testing of z/OS applications by providing
development support for traditional runtimes like CICS, IMS, DB2,

and batch

ebShere software
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WebSphere software

z/OS Application Development

Software prerequisites

I




Workstation Prerequisites

= [nstall and configure Microsoft Loopback Adapter

= [nstall the z/OS Application Development Tools on disk 2 of

WebSphere Studio Enterprise Developer
= Modify HOSTS file (Windows 2000 only)

ebShere software
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Host Software Requirements

z/OS or OS/390
IBM HTTP Subsystem: APPC
Server JES CICS, DB2,
g IMS.......
7 - ) Language Remote
Foreign File Job Monitor Environment Commands
System server server server
Debug Tool (IGYESERV)
B TCP/IP [l

Windows NT/ 2000 / XP

. TCP/IP

WebSphere Studio
Enterprise Developer

| Microsoft Loopback Adapter |

ebShere software

[l
[yl
i
LT}

1k
il
1




z/OS Prereq. Software List

= |BM HTTP Server

= JES PTF to enable job monitor support

= | anguage Environment PTFs to enable z/OS IDE support
= [BM Enterprise COBOL for z/OS and 0S/390

= [BM Enterprise PL/I for z/OS and 0S/390

= [BM Foreign File System Server [Ge
= |[BM Job Monitor Server B8
-0 debuggar
= S
=
—software

e il i T

Host Software Install Steps

= Make sure required software and service updates installed
»TCP/IP
»Language Environment
>|BM HTTP Server
»RACF or equivalent
»|BM Enterprise COBOL
»|BM Debug Tool
= [nstall foreign file system server and job monitor server
= Configure the IBM HTTP Server
= Configure the software that comes with WebSphere Studio
Enterprise Developer for the host to support remote
edit-compile-debug
»Foreign file system server
> Job monitor server

e il i T




Host Software Install Steps ...

= [nstall and configure the TSO command server to support issuing
TSO commands from the workstation
= Configure Debug Tool for remote debugging under CICS

= Test the connections

ol
i
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ebShere software
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Troubleshooting

= Ensure connectivity to host systems

»Can you ping the host?

»Can you access the web server?
= http://hostsys:port/

»Can you open the web page for the host FFS system?
- http://hostsys:port/FFDS

»Are you using the right ports for the web and job monitor?
—default is 80 and 6715 respectively

il
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http://hostsys:port/
http://hostsys:port/FFDS

WebSphere software

it s mofiwane

WebSphere Studio Enterprise Developer V5.0

XML Enablement for z/OS

Jan, 2003

Reginaldo Barosa

Certified IT Specialist
1BM Boston

IBM Software Group b Qusib
roarosa@us.iom.com

WebSphere Studio Enterprise Developer V5.0

= Struts Tools
> Set of Wizards, editors, and validation support
»for the design and construction of Struts-based J2EE web applications
= Enterprise Generation Language (EGL)
»Simple, high level programming specifications
»for creating full-function COBOL and Java applications
= 7/0S Application Development Tools
»Interactive, workstation-based development
»>for mainframe COBOL, PL/I, ASM applications
= XML Enablement Enhancements for z/OS applications

»Set of wizards to create XML transformation code
»and web services for XML-enabled z/OS applications

software ?;f—?—f




Key Benefits of Enterprise Developer

= Struts Tools
»Rapid design and quicker understanding of complex web applications
> Faster development with less errors of well-structured web applications
= Enterprise Generation Language
»Rapid development
»Cross platform applications (CICS, WebSphere Application Server)
»Using existing programmers with traditional business skills
= z/OS Application Development

»Extends benefits of WebSphere Studio Workbench features/tools to
COBOL, PL/l, ASM programmers

»and the z/OS applications they create and maintain

= XML Enablement Enhancements for z/OS applications

»Faster development of XML-enabled z/OS applications
and of supporting Web Services

ebShere software
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What is XML Enablement?

Enables COBOL-based applications to consume and produce
XML messages
= | everages XML parsing capabilities of IBM Enterprise COBOL V3.1

= Creates COBOL converter programs
» Inbound to convert XML messages into native COBOL data
» Outbound to convert native COBOL data into XML messages
= Creates template COBOL driver program
» |llustrate the invocation of converters
»> lllustrate the interaction with existing application
» Needs to be updated before run
= Enables communication with XML based systems

ebShere software

[l
(il
i
LT}

1k
wll|
1




XML Enablement

Input
converter
Output
converter

WebSphere
COBOL Studio
Data Enterprise ,
(or complete XML
program) Enablement

\ XML schema

definition (.xsd)

= Enables COBOL-based applications to consume and produce XML
messages

» Original COBOL program unchanged

Benefits of XML Enablement

= Enterprise Modernization:
>Easy to "reface” existing COBOL applications to support XML messages

= Programmer Productivity:

»Converter programs are generated to easily convert between XML and
COBOL datatypes

»Template program generated which illustrates how converter programs are
used with existing COBOL

»Exploits customers' existing assets/skills/literacy

= Performance
»XML parsing/conversions run on z/OS

ebShere software
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2 coordinates occurs 5 times)| XML to Data
3 x pic 9(4)v9(4) binary. Structure
3y pic 9(4)v9(4) binary. Converter

3 z pic 9(4)v9(4) binary.

Li nkage Section.
1 XM.-Interface.
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XML Enablement - Runtime Scenarios

WebSphere CICS/IMS Systems

. [SOAP server | CICS/IMS
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builtfroml
XMLbased Web Service generated drver e SR

application
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call Edata
B New COBOL app y 7/0S
XML-based m Senerated Existing
lication 10 %3 driver XML COBOL
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General Limitations

= \Workbench
»MVS Project cannot be source and target (must use local project)
»Copy books must be fully expanded

= z/OS Runtime
»Usage "COMP-X" not supported
»Error handling via Language Environment exceptions
> Attributes for inbound and outbound messages not supported
»REDEFINING items are ignored

= [nbound message processing

»QOccurs-Depending-On (ODO) is supported
- No validation that group repetitions don't exceed depending on variable

»Entire XML message must be scanned
= Qutbound message generation

»Complex Occurs-Depending-On (ODO) not supported
software
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Early Availability Limitations

= Workbench

>No online help
= XML for the Enterprise white paper

= [nbound message processing
»Unicode UTF-16 is not supported

= Qutbound message generation
»Simple Occurs-Depending-On (ODO) not supported
> Trailing/leading blanks in character content not removed
» Trailing/leading zeroes in numeric content not removed

»< > ' " &not allowed in character content

ebShere software
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COBOL Compiler Support for XML

= [ntroduced with IBM Enterprise COBOL for z/OS and 0S/390 V3R1
= High-speed XML parser
»Consumes inbound XML messages
»Verifies well-formedness
» Transforms contents into COBOL data structures
»Supports XML documents encoded in Unicode UTF-16, EBCDIC, ASCII
= New XML PARSE statement
»Begins XML parse
»|dentifies document to be processed
»|dentifies processing procedure
= Processing procedure
»Controls the parse
>Receives and processes XML events
»Handles exceptions
software
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XML Parsing Flow
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Parsing XML Documents

XML PARSE xml-document
PROCESSING PROCEDURE xmlevent-handler
ON EXCEPTION
DISPLAY XML document error' XML-ERROR
STOP RUN
NOT ON EXCEPTION
DISPLAY XML document was succesfully parsed.'
END-XML

ebShere software
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XML Processing Procedure

xm event - handl er section.
eval uate XM.- EVENT
*==>Order XM. events nost frequent first
when ' START- OF- ELEMENT'
display 'Start elenenttag: <' XM.- TEXT ' >'
nmove XM.- TEXT to current-el ement
when ' CONTENT- CHARACTERS'
di splay ' Content characters: <" XM.- TEXT ' >'
*==>Transform XML content to operational COBOL data item..
eval uate current-el enent
when 'listprice'
*==>Usi ng functi on NUWAL-C. ..
conpute list-price =function nunmval - c( XM.- TEXT)
when ' di scount’
*==>Using de-editing of a nunmeric edited item..
nmove XM.- TEXT to xfr-ed
nove xfr-ed-1 to discount
end- eval uat e
when ' END- OF- ELEMENT'

ebShere software
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Sample application topology

y 3270
7

CICS
Terminal

Interactive
Program

"LEGFRNT"

z/0OS CICS

Account
Details
"DFHOACTD"

Customer
Details
"DFHOCSTD"

ebShere software
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Running the existing 3270 CICS legacy application

/

VAN IV VAN
_

NN

_ |

\ | \ | /

PLERSE CHOOSE A TRANSACTION:

1. CUSTOMER DETAIL SCREEN
2. ACCOUNT DETAIL SCREEN

ENTER YOUR CHOICE ====> 2

'

ACCOUNT DETAIL

ebShere software

LUSTOMER NUMBER:| 00001

ACCOUNT NUMBER: 0Q@ROZ

BALANCE: 9,000,

SCREEN

J
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/-\ Inbound XML
Converter
XML "ACTDCNVI"
Converter
Internet or DIUE] <
Web ACTDCNVD Outbound XML
Services Converter
"ACTDCNVO"
cics InPteractlve
Terminal . gl .
XMLFRNT
/—\ Inbound XML
Converter
Internet or XML "CSTDCNVI"
Web Converter
Services Driver <
"CSTDCNVD" Outbound XML
Converter
K’/ "CSTDCNVO"

Account
Details
"DFHOACTD"

Customer
Details
"DFHOCSTD"

s 7/7|/7| NN/
C NV
N > <
- N B A
\ | A | ’

ENTER YOUR CHOICE ====> 2

;NS

N

PLEASE CHOOSE AN XML ENABLED TRANSACTION:
1. DB2 BANKACCOUNT TABLES FOR THE CUSTOMER DETAILS
2. DB2 BANKACCOUNT TABLES FOR THE ACCOUNT DETRILS.

Y

<?xml version="1.0"?><{message>
>0.0</balance><{/message>_

<custno>1</custno>

<acctno>0</acctno>

<balance

|

<{?xml version="1.0"?><{DFHCOMMAREA>{custno>

<bal ance); 9000, 53¢ /balance></DFHCOMMAREA>




Errors messages parsing input XML data

<?xml version="1.0"?>{message> <custno>1<{/custno> <acctno>0</acctno> <balance

>0.@<balance>Kk/message>

£?xml version="1.0"?><failureResponse> {errorMessageNumber>000000280</errorMessa
geNumber)(errorCode)BE)E)EJE)EJE)DS(/errorCode)(errorMeSsage)(!?CDHTH‘? IGZR280S XML
to data structure conversion could not complete in program "ACTDCNVI" because a
n error return code of 5 was received from the XML PARSE statement. The error oc

curred at elemen with the character content "???".

"">{/errorMessage> </failureResponse>

{?xml version="1.0"?><{message> (custn/custno) {acctno>0</acctno> <balan

ce>0.0</balance><{/message> /

""><{/errorMessage> </failureResponse>

£?xml version="1.0"?><failureResponse> <errorMessageNumber>000000284</errorMessa
geNumber><{errorCode>000000284</errorCode><errorMessage><!YCDATAY I1GZ02848 XML
to data structure conversion could not complete in program "ACTDCNVI" because c

onversion of the character content of an element that is mapped as numeric faile
d. The error occurred at elementl"custno" with the character content "xxx" I
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XML enable tools on WSED - Example
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Inbound converter - Example...

DFHOACTD.cbl ACTDCNV.cbl ACTDCNVO
Process opt, lib,codepage(01140)
LT A BTG, Identification Division.
PROGRAM-1D. DFHOACTD. Program-Id. "ACTDCNVI®.

Author. GENERATED.

** o ==
LINKAGE SECTION. . (é(r:tnEé;EMENT NAMES:

01 DFHCOMVAREA. ** <acctno> ACTDCNVI
05 CUSTNO  PIC 599999. “x chalance>

05 ACCTNO PIC S99999. 01 -DFHCOMMAREA
03 GRUNEE T s 05 CUSTNO  PIC 599999 .
| 05 ACCTNO  PIC 599999 .
PROCEDURE DIVISION. 05 BALANCE  PIC S9999V99 .

1 a-input-xml-len  pic 9(9) binary.

SRR 1 a-input-xml pic x(1024000) .
1 a-optional-feedback-code pic x(12).
MOVE 999999999 TO ACCTNO 1 a-converter-return-code pic s9(9) binafy.
MOVE "SQLCODE: * TO MSG. procedure division using
MOVE *DFHOACTD PROGRAM STARTED. * TO TMP. :F:‘gorrAz'ﬁ? e
EXEC CICS WRITEQ TD QUEUE('CSNT") a_i";ut_xml
FROM(TMP) a-optional-feedback-codp
= LENGTH(40) RETURNING
END-EXEC a-converter-return-code]
. Mainline Section.
if a-input-xml-len > 1024000
MOVE CUSTNO TO HV-CUSTNO. move 285 to a-msgno
perform a-signal-condition
goback
T end-if
EXEC CICS RETURN perform a-register-exception-handler
END-EXEC. xml parse a-input-xml (1l:a-input-xml-Ign)

processing procedure a-xml-handler
thru a-general-logic-exit
on exception

perform a-unregister-exception-handler

perform a-signal-condition
not on exception

perform a-unregister-exception-handler
move zero to a-converter-return-codp
DFHOACTD.xsd DDRV.cbl endal —

ed in converter

xml parse a-input-xml (1:a-input-xml-len)
processing procedure a-xml-handler
thru a-general-logic-exit
on exception

perform a-unregister-exception-handler
perform a-signal-condition
not on exception
- perform a-unregister-exception-handler
move zero to a-converter-return-code
end-xml




Outbound converter - Example.
DFHOACTD.chl ACTDCNV/chl

Process opt,codepage(01140)
IDENTIFICATION DIVISION. Identification Division.

PROGRAM-1D. DFHOACTD. Program-1d. “"ACTDCNVO".
Author. GENERATED.

Date-Written. 10/8/02 1:02 PM.

Data Division.
EINKAGERSECTIONS Working-Storage Section.
01 DFHCOMMAREA. Local-Storage Section.

-

05 CUSTNO PIC S99999. a-xml-response.

2 pic x(21) value "<?xml version="1.0"?>"
05 ACCTNO PIC $99999. 2 Eic x§13§ value *<DFHCOMMAREA>® .
05 BALANCE ~ PIC - 2 pic x(8) value "<custno>".
|_ 2 CUSTNO pic -9(5)-
PROCEDURE DIVISION. 2 pic x(9) value "</custno>".
2 pic x(8) value "<acctno>".
START-PARA. 2 ACCTNO pic -9(5).
2 pic x(9) value "</acctno>".
MOVE 999999999 TO ACCTNO 2 pic x(9) value "<balance>".
MOVE *SQLCODE: * TO HSG. 2 LU (1 SXENA@L
MOVE *DFHOACTD PROGRAM STARTED. * TO TMP. ; E:i §82§ x::ﬂ: .Zj‘;iﬁgg,j;;m._
EXEC CICS WRITEQ TD QUEUE("CSNMT™) Linkage Section.
FROM(TMP) 01 DFHCOMMAREA .
05 CUSTNO PIC $99999 .
EYE () 05 ACCTNO PIC S99999 .
L END-EXEC. 05 BALANCE  PIC S9999v99 .
MOVE CUSTNO TO HV-CUSTNO. Procedure Division using
DFHCOMMAREA
a-output-xml-len
R a-output-xml
EXEC CICS RETURN a-optional-feedback-cdde
END-EXEC. | I returning
a-converter-return-code.

Mainline Section.
move corresponding DFHCOMMAREA
to a-xml-response

End Program “ACTDCNVO®.

DFHOACTD.xsd ACTDDRYV.cbl [actoonvil

DFHOACTD.cbl ACTDDRYV.chl

Process opt,lib,codepage(01140)
IDENTIFICATION DIVISION. * XML Converter Driver Program

FREERID. [ Identification Division.
Program-1d. *ACTDCNVD" .

LINKAGE SECTION. Data Division.
Wl BAREDILARZA, 01 DFHCOMMAREA .
05 CUSTNO  PIC $99999. 05 CUSTNO  PIC 599999 .
05 ACCTNO  PIC $99999. 05 ACCTNO  PIC 599999 .

05 BALANCE PIC S9999v99 .
Linkage Section.

05 BALANCE PIC

PROCEDURE DIVISION. * ** New XML Inbound / Outbound Interface **
START-PARA. —I 1 a-xml-interface.
2 a-interface-xml-text-len pic 9(9) binary.
2 a-interface-xml-text pic x(1024000) .
Procedure Division using a-xml-in

Mainline Section.

<?xml version="1.0" encoding="UTF-8"?>
<schema *
targetNamespace="http://www.DFHOACTD. * . EXEC CICS LINK
xmins="http://www.w3.0rg/2001/XMLSchema™..."> * PROGRAM("LEGACY")
| <complexType name="DFHCOMMAREA"> : COMM'AREA(DF.HCOWAREA)
<sequence> . call "LEGACY" using DFHCOMMAREA
<elenent nane="custno> ;inbuund-conversiun.
e call “ACTDDRVI®
<restriction bas using
<mininclu; DFHCOMMAREA
<maxInclusive value="99999"f> a-interface-xml-text-len
</restriction> a-interface-xml-text
</e IZ"SEI""‘EETWP a-outbound-conversion.
call "ACTDDRVO"
SCUIEIENT MEE=ESE R using  DFHCOMMAREA  a-interface-xml-text}-len
e a-interface-xml-text
</elenent> ACTDCNVO .
</sequence> returning "
</complexType> a-converter-return-code
</schena> DEHOACTD.xsd ACTDCNVI End Program "ACTDCNVD® .



http://www.DFH0ACTD
http://www.w3.org/2001/XMLSchema"...

Modifying the converter driver programs - Example

Process opt,lib,codepage(01140), cics
* XML Converter Driver Program *
Identification Division.
Program-Id. 'ACTDCNVD".

Data Division.

*** | egacy Application Inbound / Outbound Binary Interface **

*

01 BEHCOMMAREA BUSINESS-DATASTRUCT.
05 CUSTNO  PIC S99999 .

05 ACCTNO  PIC S99999 .
05 BALANCE PIC S9999Vv99 .

* kkkkk

* kkkkkkk

*** New XML Inbound / Outbound Interface **

1 a-xml-interface DFHCOMMAREA.
2 a-interface-xml-text-len pic 9(9) binary.
2 a-interface-xml-text  pic x(1024000).

Modifying the converter driver programs - Example

Procedure Division using-a=<r-interfase DFHCOMMAREA.
Mainline Section.

move a-failure-response

to a-interface-xml-text(L:a-interface-xml-text-len)
perform a-unregister-exception-handler

exec Cis return

end-exec
end-if
L +
* | Execute Legacy Application |

* . EXEC CICS LINK

*. PROGRAM(LEGACY')

*. COMMAREA(DFHCOMMAREA)
*.END-EXEC ..OR

*

* . call LEGACY" using DFHCOMMAREA
exec cics link
program(‘DFHOACTD")

commarea(BUSINESS-DATASTRUCT)
end-exec

Execute Outbound XML Transformer |
________________________________ ¥
perform a-outbound-conversion

*|
* 4

* | Unregister Exception Handler |
i — +
perform a-unregister-exception-handler
L +
* | Finished |
L — +
-goback

exec Cis retun
end-exec




= Facilitate enterprise modernization by refacing existing COBOL
applications to support XML messages

= Achieve significant productivity gains by utilizing the converter and
driver template generators

= Gain performance benefits by running XML parsing and conversions
on the z/OS systems

= Reduce Total Cost of Ownership (TCO) by having one development
environment

ebShere software
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WebSphere software

WebSphere Studio Asset Analyzer V2
Rapid Impact Analysis and Component Reuse for
e-business

IBM Software Group

Enterprise Modernization

= What is it?
> Enterprise Modernization is the liberation of core business assets to satisfy

new e-business application development

= \Why modernize?
»Reuse is cheaper than writing new
»Bridge the development skills gap with a common toolset for both Web and
Legacy programmers. (1.3 Milion cosotdeeopers
»Leverage existing systems, applications and skills to create Dynamic
e-business with excellent Returns on Investment.
»Accelerate the e-business adoption for competitive advantage
= \Why IBM?
»|BM customers have significant business knowledge invested in enterprise
systems (over 180 hillion LOC and 5 Billion new each year)
> Customers want to leverage Qualities of Service built in enterprise systems
>Web Services makes it easier to leverage these assets today

ebS & software 2=




Enterprise Modernization Challenges/Hurdles

= | egacy not ready for integration into Web Applications
» Tedious and costly manual analysis and harvesting

= Scarcity of Skills and Steep learning curve ) :
» Complex new/emerging technologies NHW@HW“
> Massive amounts of traditional technologies
»Need to include new developer communities

= Multiple Artifacts
» More complex Application design
» Fragmented development process
» Multiple point tools and multiple skills must be in place

= Clashes between development groups
» COBOL developers know the enterprise applications, hold

knowledge
uch backlog and not enough time to deliver

bSphere Sl
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Enterprise Modernization Strategy

Completion - speeds the movement of applications
from the development process through system test to

production

Completion

Construction Collaboration
Construction -
provides visual
tooling to include
traditional and
business oriented
developers in the
delivery of mission
critical J2EE
applications

Collaboration -
facilitates team
development of
component based
e-business
applications across
the enterprise

Connection Componentization

Connection -helps connect and
reuse legacy enterprise applications
for e-business by using connectors

Componentization - promotes the
transformation of legacy Enterprise
Applications into components and the
integration of these components into new
e-business applications.

ebShere software
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® Deliver knowledge across applications to all

enterprise developers by enabling

»rapid application understanding

»rapid application change

»rapid application reuse including componentization

w B tabases
W -

=

C—_— Appl Servers
Communication

Goal: providing business knowledge through all
W. hases of the development lifecycle
eb

SN software

Transactional Systems
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Assumptions

= A typical site has invested 100M in S/390 applications
» 50 developers x 100K loaded cost x 20 years

® Sjtes want to reuse these assets
» Too much spent on Y2K refurbishment to throw away
» Reuse will get you to market faster withhigher quality

® |[nternet, batch, and integration to core processing are
requirements for success

e o

Customers Employees Applications Partners

Single Virtual Application

Business Logic

il
L]
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Integration is Key

® There are two ways to integrate or connect existing applications
»via information presented in a Ul (user interface)
»via well defined interfaces or connectors-Service Oriented Architectures*(* Gartner
Group Definition)
= For both however, a detailed understanding of how information
moves through the application or is processed by the connector is
required
= Web enablement requires separation of Ul, Control, and Data
Processes
2 e P 2 B

Partners Suppliers

Components

Process ) m *. 5
Participants L
i 5 T

Partners Suppliers
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e-Business Change/Scenario

= Goal
= Deliver the capability for a customer to do a direct lookup of
their order status.

m The Application

» Create a web application from an existing 3270 CICS or IMS
based application using WebSphere Studio Asset Analyzer
and VisualAge Enterprise Suite Tooling or WebSphere Studio
Enterprise Developer

m The Players
» System Analyst/Project Lead
* CICS COBOL/PL/I Developers
» eBusiness Developers
» QA Specialists
* Managers

ebShere software
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WebSphere Studio Asset Analyzer

End-to-End Asset Analysis

= End to End zOS and Distributed Infrastructure.
= End to End Understanding and Community
= End to End Component Identification and Reuse
= End to End Development and Process

ebShere software

Serena
Changeman ZMF

SCLM
PDS
Other SCMs

ivebsphere

Customer AD

Enterprise

artifacts

COBOL
PL/1
Assembler
IMS/DC
CICs

Batch

Customer
business analysts,
system analysts,
developers, testers,
project managers

S software

Source

.“m Scanning Tools

Knowledge
Store (DB2)

Source

anning Tools

Connector
Information

i VisualAge
| Enterprise Suite

WebSphere
Studio
tooling

Enterprise
Customer AD
artifacts

v @

Java

C++

WebSphere
applications

Rational
Clearcase

File Server
WebDAYV server




Source

Text file for
data
transport

Analysis Tools

Inventory

Import U D B ‘— Reconciliation

Interrelationship
Analsysis

7

. Web browser

ebShere software

End-to-End Understanding and Community

=} IBM WebSphere Studio Asset Analyzer - Microsoft Internet Explorer = |EI|5[

File Edit “iew Favorites Tools Help

Minirnize
J d=Back ~ = - () it | Qi Search  [GgFavorites & #History | By S5 2
J Links @IBM Business Transformation @IBM Internal Help @ IEM Standard Software Inskaller @ IBM Standard Software 2
J Address I@ http:fireeng.stl.ibm. comfdmb/DmhPageServlet? pagetype=searchal@menustate=1 &dmhRequest= ;I PGD

IBM WebSphere Studio Asset Analyzer

splore Connect Inwentory ) < Help

with IBM webSphere Studio Asset Analyzer, you can explore your /25 and distributed assets, analyze the impact of a
proposed code change. create information for connector builder tools, and extrack relevant code segments for reuse,

Search for z/08 and distributed assets

Use ane or more asterisks [(*) to locate all assets that rmatch the pattern of your search argurnent (such as *CUST*),

e |

[ Type mixed case

Search: I

Helpful links

» Simplified support to access
. oo and scan artifacts from a
Blemited scaate common interface

=]

< Aszszets by application
O Aszsets by site
=]
=]

o]

® iew

Connecor builder projects
Analyze-change projects |




IBM WebSphere Studio Asset Analyzer

=0 Explore
z/0S5 assets | Distributed assets |

Explore z/0S assets

Use one or maore asterisks [*) to locate all assets that match the pattern of your search argurment (such as *CUST*),

Go | Advanced s2arch

Search: I
I Type mixed case

Inventory Total Runtime Total Program Total Data Total
Application 5 Batchjob 52  Analysis concatenation set 5 Data elament 7873
Library 21 CICS group 2 BMS map definition 1 Dataset 310
Marmnber 425 CICS online region 1 BMS rmap set definition 1 Data store 20
Project 32 CICS transaction 4 Entry point 85 DL name 1418
Site 1 IMS subsystermn 3 Literal 2165 I/O record description 153

IME transaction 23  Program 59  SGQL column reference 38

Fun unit 58 SQL table reference 13

ebShere software

z/OS Visualization

‘Graph actions

Zoom in Zoorm out Zoom all

PRICE_MASTER
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z/OS Program Detalils

B e ere 0 Asset A e
Explore
z/0S assets | Distributed assets |
Program details
Member: DMHSRCLE Actions
Prograrm: QADOL Code extraction
Languageftype: COB / Program source Identify analysiz concatenation set
Analysis status: Completed Identify analysis options
Member record count: 399 Queue for analysis
Prograrn record count: 523 View source
Library: PHGD.STUDIO.SDMHSSRC Wiew program data elernents
Site: STLADSZE Wiew e-buziness program information
Data base updated: 4/16/02 11:03 AM by DAVINLL
| Analysis concatenation set used: DMH1

The fallowing tables list the components related ta the Program, QaD01 .

Source files included

Member (3) |Language |Type Analysis status Member record count Source location

DMHSRCOE COR Included source Completed 13 PEGL.STUDIC, SOMHSSRCIDMHSRCOE]
CMHSRCOT COB Incduded source Completed 19 PEGD. STUDIC, SDMHSSRCIDMHSRCOT
DMHSRC11 COR Included source Completed 33 PEGD. STUDIC, SDMHSSRCIDMHSRC11]
|Ent|1r point (1) |Type

| aD0l |prirnarl,l
<i | >|

Understanding Distributed Assets

Explore
z/05 azzetz | Distibuted assets |

Explore distributed assets

Use one or rore asterisks (%) to locate all assets that rmatch the pattern of your search argurnent (zuch as *CUST*),

search 98| aduanced search
Source types Total
| Java sources 1251
C/CH+ sources 238
HTML docurments 520
Compiled Java classes  E£486&
JSP pages 148
JZEE EAR files 4
JZEE WAR files =
EJBs & EJB jar files 36
AML documents £07
JZEE clients 3
J2EE tags & tag libraries 238
Text filas 226




Explore

zf 085 assets |

Distributed assets |

EJB jar file details

Name:
Project:
Description:
Client jar:
Path:

Last modified:

EJBs

Trade Sample EIB Actions
altesterawl view eib-jarxml

download jar file

K:i\AssetlocatortestCraw\TradeSample. ear@TradeElBs.jar
2001-10-17 16:35:08

TradeSession
KeySequence
TradeProfileBean
TradeHaldingbean
TradeQuoteBean
TradeAccountBean
TradeReqistryBean
FeysEntityBean

Reference graph

Zoorn in Zeoorm out Zoom all

ebShere software

Distributed Asset Visualization

Reference graph

Zoom in Zoom out Zoom all

::1 Tradﬂ.aqzlr-e.ear;
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Discoverv/Plan Application  Business  Change Data E-Business
S y Knowledge  Knowledge Knowledge Knowledge edge
« Understand components A>' $
'Mmmmm//mmxmwm e d e
: i::g }'(r:éll_nsacuons « Create data flows « Create schedule

« Narrow Scope

Find Relationships,

Tooling

WebSphere Studio Asset Analyzer

ebShere software

Netscape 1 Userieface

Application Knowlege

Application
Knowledge

List Artifacts

ind parts

Used by To

* System Analyst/Project ¢ |nitially define knowledge
Lead or impact

* CICS/IMS Developers « |teratively reduce scope

* COBOL/PL/I Programmers = Search for information

* eBusiness programmer * Communication

& Business Analysis ¢ Workflow
* Managers * Training and product
* QA Analysts documentation

- software

Perform
initial scope

« Define application « Define artifacts of » Find Transactions
et problem spa « Get reusable parts interest * Find JCL
Research solution: « Define interactions points « Eliminate non-affected = Add or subtract
Get training between application artifacts

ob Step

 Record

Reduce
Scope

artifacts as necessary

Output:

* |Impact analysis project

* Knowledge of application
artifacts or parts

* Definition of scope

Program

[l
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Business Knowledge

Business Identify Perform Reduction of
Knowledge process flows process scope scope

® Define business « Define artifacts of e Find Transactions
processing of interest interest ® Find JCL
¢ Eliminate = Add or subtract

efine process
_understanding

non-affected artifacts as
artifacts necessary

Used by To

® System Analyst/Project @ |nitially define business ]

Lead processing .

® CICS/IMS Developers * |teratively reduce scope .

& COBOL/PL/I Programmers e Search for information

* eBusiness programmer * Communication

® Business Analysis ¢ Workflow

* Managers ® Training and product

¢ QA Analysts documentation

ebShere software

miii=] Explore
z/0S5 assets | D[istributed assets |

Project details: Analyze-change results

Project: Phil - 1 de Actions
Descriptiont ORDSTA-PART-MO Show cornponent details
Project type: Irmpack Analysis - Field declaration change Show structure diagrar

Prograrn/Element: QADOL /ORDSTA-PART-NO
Createdflast updated: 4/16/02 11:50 &AM by DAVINEL f 4/18/02 7:235 AM by DAVIMEL

0 CICS Transactions 2 2 €IS Transactions .
0 IMs Transactions J | 6 Batchcubs J 0 IMs Transactions J DBated ijsJ
1 a 1 = . |
Direct impacts| Indirect impacts|

Starting with 1 data elements

in 1 programs. 3 Data sets 5 pata elements
18 pata elements £ Dpata stores 4 Erograms
0 IM5 segments

0 Entry points
0 other impacted programs

2 sgL table references

4l
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Change Knowledge

Change

Knowledge impact

Produce a
statement of

work
change

Used by

® System Analyst/Project Lead
® CICS/IMS Developers

¢ COBOL/PL/I Programmers

¢ eBusiness programmer

* Business Analysis

* Managers

* QA Analysts

Identify detailed Size project

@ Use information
gathered thus far
to generate scope
of application

Schedule
project

® Segment and
Schedule

C ene rate

Hi o ment of
1}y §iFortand
i D

/

To Output:
® Statement of Work

* Assignees and schedule

® Generate project plan
® Assign staff

® Search for information
e Communication

* Workflow

¢ Training and product
documentation

ebShere software

Data Knowledge

Data Identify Scope to Change as
Knowledge Connections processes of required
via data interest
ain knowledge ® Follow processes ¢ Understand data * Use IBM File
ata components across data flows ggﬂggtsig:gstgnd Manager
application application
Used by To Output:
® System Analyst/Project ® Generate project plan * Data flow and definition
Lead ® Assign staff
® CICS/IMS Developers e Search for information
* COBOL/PL/ ® Communication
Programmers * Workflow
e eBusiness programmer * Training and product
* Business Analysis documentation
* Managers
¢ QA Analysts = [ 3
][ e e
<«

ebShere software
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End to End Component Identification and Reuse

Identify
e-Business fComponents Scopeand  Generate
Knowledge or E size connections

potential

] | ! ! * Understand Model, * Listconnectors B
Gain knowledge of + List Candidate E-Business View, Controller A Tova B
e-Business process il ] e Enterprise Access N |

or candidate Builder
processes

Used by To Output:
® System Analyst/Project ¢ Search for information @ Connector Understanding
Lead * Provide sizings and = Connector Generation
¢ CICS Developers evaluation for
* COBOL Programmers e-business
B * eBusiness programmer e Generate connectors
* Business Analysis « Communication
* Managers * Workflow
¢ QA Analysts ¢ Training and product
documentation

s

ebShere software

e-business Ratings

IBM WebSphere Studio Asset Analyzer
Home EXLIIDI'E & {Eefi Inventory Data
/0% assets | Distributed assets |
e-business program —
- - Action
Infnrmatlon Wiew e-business program information base table
Zearch I Jo I advanced r Type mixed

search case
Dranran i onntens Hurnber of Screeﬁ_ .%:l:lal Dats g-business transformation
=BR3US32 ines Ifos flow transfars |HOs indes

APSBELBAL [ate]-) 1287 1= i0 ] TE
APSDMOL | COR 2715 | o z| o 1o
ASSIALS PLI E3=1-3 1] 1z z &
Chseac | com 224 o 1 s 22
CHARPSC [ata]-) a2 1] o] 1z 40
CHAPEC OB 213 B A ia0 32
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Identify Select

Identify
Application / - /‘statemems
el Objects Segment

Code extraction

ot yuguartial fils name to hold ode mxtract file: [EEYWIHZ0 EATRAGT: COBGL

245 wnquartal fila nama ko held complimante fila:  [DAVINZO. COMPLEHT.CORDIL
[Tha dirsonac fortha abavs pethramer must seict anthe remerl

Ealact 3 ling. ranga of lings by holding the SMeMt key or dagoing the mousal, of mutipla ranges of lines by using the
Etell kg Fiorn this follosing Eaurce.

PROCEDURE COWVIGIOM

[NebShere software

End to End Development and Process:
An Improved Process

g::’;’::a"" Understand * Understand  Generate Assign Implement
Analyst Application Business Data Statement Developer :3:3:{;&
Structure Flow Flow of Work Success
Understand Understand  Understand Make Evaiaeh Implement
iti Current i Solution &
Traditional e, Ell:)smess Data Changes Complete S
Developer Structure W Flow MESS Success
Understand  Understand ~ Understand Connect Evaluate Ui
Java/Web Connector  Business Data Application ~ Complete  3oLton&
Developer / Candidates Flow Flow -ness [
] 2“9’5‘3"" ‘Understand  Understand ~ Generate Generate  Testand
Quality Ap:ﬁ:‘;ﬁm Business Data Statement  Test Evaluate
Analyst st Flow Flow of Work Plans Success

Enterprise Enterprise.

AD artitacts

Generator)

vepree o] 4577 H wessonee
S software o lmw il

developers, tester
Iroject managers




= Complete End-to-End analysis
= |ntegration with other tools

e Schedulers

e Performance analyzer tools

e etc.

Note: Plans subject to change.

ebShere software ??g

More Information

Visit our website:
www.ibm.com/software/ad/wsaa
= Whitepapers
= Fact sheets
= Online demo

= Services information
+ |Installation/Configuration Assistance
+ Mentored workshop

ebShere software ?gg




WSAA Benefits

= Improved developer productivity
= Reduced time to market
= Higher application quality

S * o

= [
- i Web Servers "

B @-E/ ; Databases E
Faggert

Transactional
Systems
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